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1 Introduction to civil pro

Civil pro is a quality assurance management application. It has been developed for and is tailored to
the civil construction industry but is equally suitable for any complex quality assurance task. Civil
pro can manage the QA requirements of any size project from the smallest to the largest serving as
a simple lot register or a full blown payment and documentation tracking service.

Civil pro tracks;
1. Definition of discrete products or elements (Lots)
2. Non conformance identification
3. Testing administration
4. Checklists, ITPs and compliance
5. Project photographic records
6. Payment schedule
7. Variations
8. Document revisions, distributions and transmittals
9. Progress claims and payment
10.Relationships between objects and automatic reporting on relationships
11.Work Type, Area Code and Control Line registers
12.Analysis of test results
13.Compilation of all associated information for individual lots
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2 Lot based QA

The basic principal is that each part of the physical works (and / or each process) is included in one
of a number of lots which are recorded on a lot register. All of the testing, inspection, conformance
checks and valuation of work completed is referenced back to the lot which contains the work in
question. The records associated with each lot are compiled and managed as a separable record of
completed work.

What comprises a lot is relatively simple and is explained in the section "What is a lot?"

2.1 Why lot based QA

Lot based quality assurance is structured and flexible. It can be as simple or comprehensive as is
appropriate for your project. At its very basic level, you can maintain a list of the sections of your
project and this list to collate records like tests and non-conformances. For more complex project it
can be used to record the quantity of work associated with a lot, generate progress claims, track
variations, manage checklists and ITPs and calculate appropriate numbers of tests.

Of course, sometimes you have no choice but to adopt lot based QA due to external factors such as
your contracts or legislative requirements. In these situations you need an effective method of
complying with your obligations.

2.2 What is a lot

The first step to understanding how lot based quality assurance (LQA) works  is understanding the
concept of a lot.

A lot is simply a specific, discrete section of the physical work or a process which forms part of the
works being constructed. For a small, simple project you may simply break lots as;

Pavement
Drainage
Earthworks
Management Plan Approvals

Generally on larger projects, many lots would make up each of these categories. This may be
because a section of work is too big to easily be managed in its entirety, works of a similar type
occur at different times or locations, or because of other restrictions imposed on lot definition by the
project specification.

An example of this may be the pavements where a lot could be restricted to a single day's
production with a paving machine, of a single type of gravel (such as with Main Roads Qld projects).
In this case the lots may be as follows;

Lot #ABCDEF001 – Subbase Ch 10,000 to 11,500 – day 1
Lot #ABCDEF002 – Subbase Ch 11,500 to 12,750 – day 2
Lot #ABCDEF003 – Base Ch 10,000 to 11,500 – day 3
Lot #ABCDEF004 – Base Ch 11,500 to 12,750 – day 4

When do I define a lot?
Lots can be defined before a project commences or, more commonly immediately prior to
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commencement of a section of work. It is best practice to define a lot BEFORE work starts rather
than completing work and then defining lots. Contracts are quite often very specific about the timing
and definition of lots for particular work types.

Civil pro maintains your lot in the lot register, the central reference point for all of the individual
elements of work that comprise your project.

2.3 Inspection and test planning

Each type of lot (i.e. a pavement lot, excavation lot, concrete pour lot etc.) has particular
characteristics which are inspected and tested to ensure that the work complies with the
requirements of the contract. Generally the required standard of work is defined by the contract
specification or legislated standards. It is also common for contracts to define the elements of the
works which must be inspected and tested, and how often this occurs.

Rather than trawl through the contract every time work is undertaken to determine the compliance
requirements, an Inspection and Test Plan (ITP) can be authored. This communicates very clearly to
the project team and also clients, what will be tested, how and when for each type of work.

This ITP may be simplified further, or reproduced in its entirety as a checklist which is printed off in
hard copy for use as a record that individual items have been inspected.

Civil pro has an ITP creation and management tool which also produces checklists and determines
the appropriate testing for individual Lot Types.

2.4 Testing and recording results

Tests are often required to verify that elements of work have been completed to a certain standard –
such as compaction tests or concrete strength tests. These tests can occur prior to, during or after
execution of the works. Testing requirements are generally specified in the contract documents.

It is usual that such tests are taken by a third party to ensure integrity of the results. To record the
tests that have been requested and taken, a system of Test Requests and a method for recording
Test Results is required.

Civil pro maintains a Test Request register which provides the capability to record results and
generate testing locations randomly. Test Requests are linked back to the relevant lot. 

2.5 Non conformance

No matter how good a project team is, sometimes things go wrong, whether it be unexpected rain
damaging the presentation of your concrete, a supplier providing substandard product or a process
that isn't executed correctly. In these instances, the only thing worse is when it happens again.

Identifying and managing non-conforming processes and products is an essential, and often
contractually required element of a project. The process involves identifying problems, determining
an appropriate course of action, getting that action approved and checking to see the actions are
implemented.

Civil pro provides a mechanism for recording your non conformances, cross referencing them against
lots, tracking the approval process and ensuring follow through.
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2.6 Quantities and payment

Every project has a payment schedule. The extent to which contractors are entitled to progress
payment  for work completed is determined through the percentage of each item in the schedule that
has been finished. 

It is also not unusual that payment be dependent upon the work meeting certain standards. In order
to make claims it is therefore useful to be able to identify the information demonstrating compliance
(your lot records) and associate them with specific element of your construction payment schedule.
As each lot is either complying or not, the contractor can sum the quantities across complying lots
and use this as the basis for payment.

Civil pro manages these relationships between work completed, payment and compliance. Lots are
statused as conforming, guaranteed or work in progress. Each status can be included in payment
claims or not as is appropriate for your project. If you don't need to use lot assigned quantities, civil
pro still manages your progress claim submissions independent of your lot records.

2.7 Variations

Most projects are subject to change during their life cycle. If this change incurs an increase or
decrease in costs/payments, then this needs to be tracked.

Civil pro manages variations, their association with quality assurance records and their impact on the
progress claim process through the Variation module.

2.8 Glossary

Random Stratified Sampling: In the context of civil pro this relates to a method of determining test
locations in a random fashion, while still ensuring coverage of the area to be tested. For example, if
5 tests are to be taken over an area 10m x 100m, random stratified sampling will result in there
being a single test in every 2m (10m/5m) section laterally and every 20m (100m/5m) longitudinally.

Lot A lot is simply a specific, discrete section of the physical work or a process which forms part of
the works being constructed.

Conformed Lot
A conformed lot is a lot for which all testing has been performed and results received

demonstrating compliance, all checklists are completed and any NCRs are closed out.

Guaranteed Lot
A guaranteed lot is completed and complies with the specification but is waiting on some

results of testing (such as 28 day concrete tests) or other information.

Open Lot
A lot which is neither conformed or guaranteed

Non conformance Where a product or service exhibits characteristics that do not conform to
specifications required and/or stated. This may include failures, deficiencies, defects, malfunctions
and the like. 
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3 Basics - read first

There are some important general things about civil pro that you need to know to get the best out of
it. In fact, there are things you need to know to use it at all. This section goes through civil pro's
general usage including topics such as;

How to enable editing
Accessing Menus
Interface
o Main Menu
o Using the Grid
o Detail Panel
o Related Items
o Common Grid Functions

3.1 Enabling editing

The most common interface in civil pro is the grid, which is simply a user customizable list of a
particular type of civil pro Data, such as the Lot Register.

Whenever you first open a register you will not be able to add, edit or delete records. You can enable
adding, editing and deleting by opening the grid's context menu (right click on the grid) and clicking
"enable editing", or by using the same button positioned in the bottom left of each register in the
toolbar.

You can set your forms to be enabled for editing by default by selecting "Project => Grid Editable as
Default" from the main menu. This can be set to enabled if you set the appropriate constant.

Fig 1. Enabling editing
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3.2 Accessing menus

Civil pro has several different menus, some of which are "context" menus, meaning their content is
different depending on what you are viewing and where you click. To make civil pro as simple to use
and uncluttered as possible, we have implemented a range of different menu types which will
become second nature to use after only a short while.

The menus are;

1. Main Menu - Found at the left of your screen once start civil pro, this is where you choose what
information you want to view and update. Each type of view (or form) is contained within one of the
panels, Quality Assurance, Payment, Specifications and conformance etc. Each of the panels ()
can be expanded and collapsed by clicking on the arrow. To access a form, click on the text or
icon representing it.

2. Header context menu - This menu allows you to change sorting, group and show/hide different
columns on the grid. It is accessed by right clicking on the column heading of any grid (the grey
bar at the top of the lot register below).

3. Grid context menu - This provides access to a menu which is specific to the current data shown
in the grid. For example below functions for Guaranteeing and Conforming lots are relevant only to
the lot register and are not shown on other pages. It is accessed by right clicking anywhere on
the grid. Please note that sub-grids have their own context menus which can be quite different to
the main grid's context menu.

4. Detail context menu - The detail context menu provides access to a menu specific to the detail
for an individual record. It is accessed by right clicking on the detail area.

5. Footer Menu - The footer menu is a quickly accessed menu at the bottom of the page for
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commonly used operations. This menu can include sub-menus (such as the report menu shown
below), buttons - such as the New Lot button and even drop down boxes.

6. System Menu - This is the main menu at the top of the page (below with headings Project and
Users). These menus are accessed by left click and operate like standard menus in any other
windows program.

3.3 Deleting

Related Items

Most relationships shown in the Related Items can be deleted by selecting them and pressing the
delete key. Items that cannot be deleted this way are things like the test requests in the Lot
Register where doing so would mean deleting an entire Test req. as the Lot Number is a property of
the request itself.

Register Entries

Most items shown in a register grid or its sub-grids can be deleted after enabling editing in the grid
context menu. Simply select the records to delete and press the delete key.

Editor Values / Clearing Editors

Sometimes you enter values in editors (like drop downs and text boxes) that you don't want. If you
haven't moved away from the cell, you can usually undo the entry by using the escape key. If you
need to go back and remove an entry, press ctrl+delete (please note any popup editors must be
closed). This will change the value in the editor to NOTHING (or null in computer speak). It is
important to understand that just because an editor does not display a value, it does not necessarily
mean it contains nothing - it may be what is called an empty string or a white space. This is rarely a
problem but if you are getting an error suggesting a value exists where you can't see one, and don't
want one - just use ctrl+delete to clear it completely.

Cancelling Edits
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To cancel an edit, press the escape key.

3.4 Performance Tweaking

Many things can affect the performance of civil pro and its responsiveness. The most important thing
is the quality of the connection between where you are running civil pro and where your data is
stored. If you have good communications, there is nothing to worry about and you can completely
ignore this section. But if you don't...

1. Are you the only user for your database? Or are you the main user with others looking at your
data once a month or so? In this case, you should consider switching to a file based version of civil
pro (standalone) with the file on your (backed up) local machine. If someone needs to see your data
once a month, just send them the file (make sure they have a log in). 

2. Try the "slow connection" mode. This is activated by selecting the slow connection button in the
Project main menu. This reduces the amount of checking civil pro does to make sure it shows the
most recent data. By default, every time you change rows, print a report etc. civil pro checks to
make sure the data is accurate and fetches Related Items. If you only need to see related items for
specific items rather than every time you change records, have few users accessing your project, or
are happy to use the refresh button when you want to check data this may be the option for you.
This can be set to default using a constant.

3. Talk to us about terminal servers and project transfer options. These can be tricky and may
require some server admin.

3.5 Printing and reports

Civil pro's registers can be printed or exported using the menu option in the bottom left of each
screen (see Fig 1). When a report is printed, it is shown in a print preview form first where you can
choose to export data to other formats, change margins and page orientation and scale the reports
to fit pages.

When you print reports such as an NCR report or test request, one or more pages is printed for the
record, as opposed to when a register is printed where each record is a single line in a table. With
the NCR and test request like reports, civil pro will create reports for each record you currently have
selected in the grid. For example, if you have three NCRs selected and you choose to print an NCR
report, civil pro will open the print preview with each of the three NCRs printed sequentially with a
page break in between. If of course you only want to print one report, simply select a single one to
print.

One of the options on most registers is "print grid". This is a very flexible report that sends the
current grid layout to the report. This means any filters, grouping, column resizing or other
customizations you have applied will be reflected in the report. If you want to see information not
shown in the grid as standard, use the grid header context menu to show the column list, and add
the column with the information you require. It will then be displayed in the report. 

If your column is cutting off text that doesn't fit in the cell, or you want to see the information in sub-
grids, use the autofit and expand options available in the grid context menu - see Common grid
functions. If your column isn't wide enough on the report, change it in the grid and rerun the report.
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Fig 1. The lot register w ith the Reports menu opened

3.5.1 Print preview

When a report is opened in civil pro, it is shown in preview mode (Fig 1.). This allows you to tweak
your report prior to sending to the printer. 

NOTE: Some reports have additional tabs at the top of the page allowing for further customization of
the report output. These reports include the conformance report, NCR and the checklists.

The menu bar options are;
1) Document

a) Open - Opens a previously saved report
b) Save - Save a report to disk (only viewable in the civil pro report viewer)

2) Print / Quickprint - sends to the printer
3) Page setup

a) Header/Footer - Allows entry of additional information above and below the report
b) Scale - change the zoom level of the report or fit to a set number of pages.
c) Margins - change the top, bottom, left or right margin spaces
d) Orientation - landscape or portrait
e) Size - The output paper size - A3, A4, letter etc.

4) Navigation
a) Find - Find words in the report
b) Next  / Previous / First / Last page - navigate through the pages

5) Zoom - These functions are as per standard word processing functions
6) Page Background

a) Page Color - change the color of the page behind the report
b) Watermark - prints a standard text or image behind the report to help with identification or

discourage unauthorized duplication
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7) Export
a) Export To - exports the report to PDF, HTML, MHT, RTF, XLS, XLSX, CSV, Text or Image
b) Email As - emails the report as PDF, HTML, MHT, RTF, XLS, XLSX, CSV, Text or Image

Fig 1. The Print Preview form

3.6 The interface

Most of the pages in civil pro are displayed in a grid containing lists of similar data (the lot register)
with panels for related data and record detail, or in a single form containing information for a single
record (New lot wizard). 

This section focuses on the grid type interface which has a lot of functions common to each page.
The most heavily featured grid page is the lot register so this section on the civil pro interface uses it
as its example.

This section describes each of the main areas of the interface including;
Main Menu
Grid Panel
Related Items
Detail Panel
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3.6.1 Main menu

Most of the civil pro registers are accessed from the main menu positioned at the left hand side of
the screen. The main menu is split into 4 sections which can be collapsed or expanded to show the
individual menu items. 
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3.6.2 Tool Tips

Most of the menu functions in civil pro have tool tips explaining what they do. Where there is a tool
tip, simply hover over the button, and the tool tip will be displayed.

Tool tips work for context menus and items in the bottom menu.



22 Civil Pro Help v8.8.51

© 2014 Blue Sky Contracting P/L



23Basics - read first

© 2014 Blue Sky Contracting P/L

3.6.3 Using the grid

All of the civil pro registers are displayed in summary using an excel like grid. The civil pro grid is a
very flexible interface. Understanding how to use it makes civil pro even more powerful. 

Fig 1. Accessing common grid functions

By default, the grid is not editable and data cannot be deleted. To enable editing, right click to
access the context menus and select "Enable Editing".

1. Reorder columns - grapping a column (left click and hold) with the mouse and dragging it will
reorder columns.
2. Showing different columns - A standard set of columns are shown when you open each
register, generally there are many additional columns available. These can be accessed from the 
header context menu and clicking Column Chooser. Drag the column you want from the column
chooser to the grid column header area and drop it. 
3. Removing Columns - A column can be hidden by grabbing it (left click and hold) and dragging it
out of the column area.
4. Filtering Data - When the left mouse cursor is over the column heading, the filter icon appears in
the top right of the column header (see the Ch Start column in the figure). Clicking this opens the
filter menu. Select the value you want to filter on, or select custom to enter a complex filter. The filter
system is analogous to that found in Microsoft Excel.
5. Sorting Data - Clicking on a column header sorts the data using the values in that column.
Clicking it again reverses the sort order. To sort on multiple columns, click on the columns you want
to sort on in order while holding shift. The figure shows the Control Line is sorted (there is a black
triangle in the header)
6. Grouping Data - dragging one or more columns into the grouping area at the top of the grid
allows users to collect similar information together. In Fig 2. the grid is grouped by Control Line as
can be seen by the control line column which has been dragged into the header. When the grid is
grouped, the expansion state and whether the grouped column is shown can be controlled through
the grid's context menu. More than one grouping can be applied to further collate like information.
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Fig 2. The lot register after the Control Line has been dragged into the group area.

3.6.4 Detail panel

When you first open the lot register you are seeing a summary of each lot. If you need to see
additional information for a particular record you can view it in the detail panel at the bottom of the
grid. This panel can be hidden or closed, and on most registers is hidden by default.

To re-open or unhide the detail pane either;
Double click on the record in the grid, the panel will open showing details for the clicked item
Access the context menu (by right clicking on the grid) and select the option to show the detail
pane.
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3.6.5 Panels and docking

Civil pro's panels can be moved around to suit your needs. If you do not like where a panel such as
the detail panel is located, grab its title bar and move it somewhere else. If you drag it over the main
civil pro page you will see anchor marks where you can drop the panel to have it dock to civil pro at
the bottom, sides or top. Alternatively you can drag it into its own window. This is especially useful if
you are doing work requiring a large viewing area (such as creating ITPs) or if you have dual monitors
where you can set the detail up on one page and the grid on another.

3.6.6 Related items

Many of the civil pro registers (the Lot, NCR, Test and ATP for a start) have a panel on the right
called the related items panel. This panel displays information related to the currently selected item
in the grid view. For example, in the figure below, lot EGGO011 is selected in the main grid and the
related items panel shows that this lot has a quantity of 217m3 for schedule item 3310.01 and is
linked to test request #2.

The related items list not only displays information, it is also a way to quickly create links to other
information. If you want to add information - say a link to an NCR for a lot, double click on the
heading (NCRs for example) and a list of NCRs for the project pops up. Select the NCR(s) you want
to link to from the list and drag them onto the related items list. When you hover over the NCRs
heading, the cursor will change - drop the items and they will be added to the list. To remove links,
select them and click delete.

The related items list can be hidden or closed using the blue buttons at the top right of the menu. To
display it again, select the "Show Related Items" option from the grid context menu (right click on
the grid).
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3.6.7 Common grid functions

There are a number of functions common to most (but not all) grid based displays in civil pro which
are accessible from the context menu (right clicking on main part of the grid). This section of the
help describes their function.

Enable editing
Grid options
o Row autofit
o Expand all
o Show grouped columns

Show detail
Show related items

Enable editing
When you open a register it is not enabled for editing, adding or deleting (unless you have enabled
editing by default). If you have the appropriate permissions you can enable editing, adding and
deleting by selecting the Enable Editing function from the grid context menu, or using a similar
button in the bottom menu. If a grid has child grids (a hierarchy where a row can be expanded to
show more data) then editing for these is controlled by the editing settings for the parent grid.

The reason for this is that it is all too easy to accidentally overwrite information and we think an extra
couple of mouse clicks is little pain compared to the likely errors that can otherwise arise. You can
set the editing status of all grids to editable as they are opened using the option in the main Project
menu at the top of the screen.
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Grid options
Row Autofit
When selected, allows the row height to automatically adjust so that columns with long data wraps
in the cell. When not selected, rows are one line high and text does not wrap.
Expand All
When a grid has a sub-grid, or is grouped this function toggles whether all of the data is expanded or
collapsed.
Show Grouped Columns
When a grid is grouped by one or more columns you can use this option to choose whether the
grouping column is also shown in the grid display.

Show detail, Show related items
If the detail pane or related item pane has been hidden or closed, this will make them visible again.

3.6.8 Finding Data

The most common ways to find data in a civil pro register are;

1. CTRL+f => when the grid is active, in most registers this will open the find dialog. To find data
simply enter your search term (refer Fig 1.). In the schedule this behaves a little differently and the
search terms are entered into the related items panel. 

Fig 1: Using the find function

2. Using the filters. Filters are available for each column, similarly to excel (refer to Using the grid in
the section Filtering Data). If you cannot see the column you want to filter in the grid, select it using
the column chooser as described in the section showing different columns (also in the Using the grid
section). 
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IMPORTANT: Filters behave differently than the find! Find looks for records with your search
term anywhere in them. When using filters, they search for an exact match. You can use a wildcard
(%) to extend your search to be like the find.

For example, to perform an equivalent search for GNR as that shown for the filter in Fig 1. in a filter
would be %GNR%. If you just wanted to find lines starting with GNR, it would be GNR%.



Part

IV



30 Civil Pro Help v8.8.51

© 2014 Blue Sky Contracting P/L

4 Setting up Civil Pro

When you first start a new civil pro project there are a few relatively straight forward steps to take
before it is ready for every day use. This section describes the steps from opening the project
through creating basic information stores and importing existing data to the point you are ready to
create your first lot.

4.1 Select standalone or server

Civil pro can be used as standalone, server or a combination of both. Which you use will depend on
a few factors (refer below). If a standalone system suits your needs it is by far the simplest and if
you need to change to a server based system later, civil pro will migrate your standalone file to a
server in a matter of minutes.

Standalone (file)
In a standalone system, all of your data is stored in a single file that you can copy just like any other
file - it is analogous to a word or excel document. This is completely different to how standalone
systems worked in previous versions. In a standalone system, each project has its own file.

Server
With a Server based system multiple projects are stored in a central location and users are common
across projects (although permissions are customized on a project/role basis). Backups, restores
and administration are all server based tasks requiring someone who knows about using a database
server (or is willing to spend a few hours learning). If you need to use your project where you cannot
access the server, you can temporarily convert it to a standalone file and back again.

The following flowchart can be used as a guide
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 Does your project require multiple users 

accessing the same data at the same time 

Are your communications good enough to access 

a central server storing multiple projects 

Use a server install 

Standalone 

Do you need to centralize your data or aggregate 

across multiple projects. 

Yes 

No 

Yes 

Yes 

No 

Does your organisation have the skills to manage 

an SQL server, or are you a capable user 

confident in learning how (it isn’t that hard) 

Yes 

Yes 

No 

No 

4.2 Log in screen

When you first open civil pro, you will see the main application window overlaid with the Log In
screen. You cannot use civil pro until you log in to an existing project, or create and log in to a new
one. 

To log in to;
the most recently used (MRU) project (listed under Current Connection in the large grey
box near the bottom of the login form), enter a valid user name and password for the project
and click "log in". 
a project you have recently used, click on the "Select Connection" button and select the
desired connection from the MRU file list (Fig 2 below).
a project you have not previously accessed, or a new project click on the "Select
Connection" button and select the "New Connection" button (Fig 2 below).
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When you open a new project civil pro will check that your application and the project are compatible
- i.e. whether your project was created by an earlier or later version of civil pro. There are three
possible outcomes of this test;
1. The application and project are compatible and you will be logged on without any message
2. The project was created by, or has been updated by, a later version of civil pro than your

application (i.e. it has been updated by someone else to work with a newer version of Civil Pro) in
this case you will be prompted with advice that you must update your version of civil pro before
you can access the project

3. The project was created by an earlier version of civil pro and has not been updated to the current
version you are using. In this case you will be prompted and asked if you want to update the
project (and any other projects on the same server in the case of a server install). If you continue,
the project will be updated, otherwise you will be returned to the log in screen.

The reason Civil Pro prompts prior to updating the database is that if you update the project, all other
users will experience case (2) and will have to update there version of civil pro as well.

For more information refer to Connecting to an Existing Project and Creating a New Project.
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4.3 Creating a new project

The initial tasks in creating a new project are slightly different for a standalone project vs. a server
project (for an explanation on the difference between standalone and server projects, go here).
Please select the appropriate topics.

Creating a standalone project
Creating a server project

Once you have done this, all other setup and usage topics are identical.

4.3.1 Standalone (file) project

New projects are created from the Connection page (accessed by clicking Select connection from
the login page).

The Connection page looks like this;

The screen above is shown if the Civil Pro Data File option is selected - this allows you to create a
new Civil pro standalone project.To create a new project click on the Select File button navigate to
the directory where you want the file to be created and enter a new file name in the file dialog.

The new database initialization will begin, followed by the project initialization. Once complete, click
on connect and you will be returned to the log in screen.

4.3.2 Server project

A new project is created from the Connection page (accessed by clicking Select Connection from
the login page).

After selecting the SQL Server option near the top of the form the Connection page looks like this;
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To create a new project;

1. Select the server from the top drop down box. You will be prompted for Civilpro to search the
whole network. If your server is on a network network, you need to say yes if you want civil pro to
find it automatically. You would answer no if the server is on the local machine, or you know the
server name and are typing it straight into the drop down instead of selecting it.

2. After selecting your server, you need to enter your credentials to access it. The type of security
will depend on how your server is set up. Get these details from your SQL server administrator.

3. Once the correct credentials are added, selecting the database drop down will populate it with the
available databases on the server. Select an available database or click add and enter a name (no
spaces) for a new one.

4. Click the Add button to the right of the project drop down and enter a new contract number and
project name.

5. Click Connect

If your project is also in a new database, the new database initialization will begin, followed by the
project initialization. If this is a new project in an existing database, only the project initialization is
required.

Once complete, click on connect and you will be returned to the log in screen.
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4.3.3 Database initialization

After creating either a new standalone file, or a new server database you will be prompted to initialize
the database. Select Yes to start the new database wizard.

The new database wizard will start. The first step is to create a system administrator who will
manage and administrative tasks and set up users. Some of the fields will be filled in by civil pro -
while you can change them it is recommended to leave that information as it is. Fields with a
coloured background are compulsory. Click Next.

You will be given a summary of the tasks to complete. Click next.
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This step is finished. You will be prompted to complete the Project Initialization.

4.3.4 Project initialization

When you create a new project, the project initialization wizard will be automatically started. The
first screen explains the process.

If you have entered the Project Initialization page without going through the Database Initialization,
civil pro does not know if you have the appropriate permission (you must be a system administrator)
to create a new project. In this case this page may also prompt for the user name and password of a
valid system administrator - you will need to enter this information to continue. If you have just
completed a database initialization, the credentials are not required and you will see the first page
as shown below.

When you are ready, click Next.
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When you start a new project, much of the information may be similar to a project you have
previously worked on, or your company may have a set of standards you need to reuse. You can
copy the set up from your previous project on the next page. Simply select the type of connection
(SQL Server or Civil Pro file), enter the appropriate details and click next. If you are not importing, or
you prefer to import specific information later - select Do Not Import.

IMPORTANT NOTE: Civil Pro can only import from projects with the same data structure as the
current version. If you have problems importing, fix the target database by simply logging in to it,
then try again.
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If you selected to import from a project, you will be prompted with a list of the data you can import -
the most common are selected by default. Review the list, and select the data you want. If you
selected Do Not Import in the previous step, this page will be skipped.

The next step is to collect key information about the project. If you have imported data, some of the
source project's data will be shown here such as the project team, location, client and
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superintendent. Enter the compulsory information (coloured boxes) and optional information,
including changes to any imported data. When you are finished, click Next.

Each project must have at least one user who is granted log in permission. Select the users who will
have some kind of access to the project from the left, then click the Add button. You can add new
users after  set up is complete. When you have finished assigning users, click Next.
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Each of the users you assigned to the project in the previous step need to have a role (for more
information refer to Access Control). The role determines what responsibilities a user has for the
project. The default roles are Project Administrator and Project User. Drag the appropriate role over
to the user on the right. When each user has a role, click Next. 

You are now ready to initialize your project. Click on the Create Project button. If you have selected
to import People and Users, it is more than likely that at least one of the users you are importing will
already exist in your current database (for example if you are copying from a project with a sysadmin
user). In this case Civil Pro will prompt you, asking how to deal with it. Most of the time you will tell
civil pro that it is the same user (default) but you can change it as needs be.

If you have selected to import data, you also need to select the user to whom the records will be
assigned once they are imported into your project
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Assuming all goes well you will see the Finish page. Click Finish and be returned to the Log In
screen.
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4.4 Project administration

Once your project is set up, you may want to update information about it or add additional
information such as a logo to print on reports. This is completed in the project administration page -
accessed from the project administration item on the project menu (located at the top left of the civil
pro main page).

A user can edit the project details for project in which they are a project administrator, or all projects
if they are a sysadmin. 

Adding, editing and deleting; Users;
Click on the Add Project button at the bottom of the screen and follow the New Project wizard.
This is the same as described in Project Initialization. 
Edit project details - simply change the appropriate details in the grid or detail panel (
Delete a project - Click on the Delete Project button at the bottom of the page. Always complete a
backup prior to deleting a project.

Fig 1 The Project Administration page

Managing Logos
To add /change a log, select the project and click on the "Get Logo" button accessed from the grid
context menu (right click on the grid). To clear the logo for the current project, use the "Clear Logo"
option also in the context menu.

File Location
The file location is used for storing files associated with Civil Pro - namely photographs. If this is a
network install, it is important that this location is accessible for all users (i.e. a network share). To
change the location, click on the ellipsis to the right of the file location box and select a folder.
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4.5 Connecting to an existing project

The method for connecting to an existing project is slightly different for a standalone project vs. a
server project for an explanation on the difference between standalone and server projects, go here).
Please select the appropriate topics.

Connect to a standalone project
Connect to a server project

Once you have done this, all other setup and usage topics are identical.

4.5.1 Connect - standalone (file)

You access existing standalone projects/files from the Connection page (accessed by clicking "
Select connection" from the login page).

The Connection page looks like this;

The screen above is shown if the civil pro data file option is selected - this will allow you to select an
existing file by clicking on the "Select file" button, navigating to the directory your file is in and
selecting the file.

Click the "Connect" button and you will be returned to the log in screen.

4.5.2 Connect - server

You can change to a different server project from the Connection page (accessed by clicking "Select
Connection" from the login page).

After selecting the SQL Server option near the top of the form the Connection page looks like this;
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To connect to a project;

1. Select the server from the top drop down box. You will be prompted for civil pro to search the
whole network. If your server is on your network, you need to say yes if you want civil pro to find it
automatically. You would answer no if the server is on the local machine, or you know the server
name and are typing it straight into the drop down instead of selecting it.

2. After selecting your server, you need to enter your credentials to access the server. The type of
security will depend on how your server is set up. Get these details from your SQL server
administrator.

3. Once the correct credentials are added, selecting the database drop down will populate it with the
available databases on the server. Select an available database.

4. Select the project from the Project list.
5. Click Connect

Click on connect and you will be returned to the log in screen.

4.6 Importing data

In addition to data transfers completed through the data transfer wizard or when a project is created,
you can import specific data from csv and civil pro specific cpx files. This section explains the
different formats.

Data imported into civil pro can be of three types. 
1. Flat table like data from any program such as a csv or tabular data from the clipboard
2. Hierarchical data previously exported from civil pro
3. An entire project - either another CP8 project, or from a CP7 project

CSV (comma separated values)
Flat table like data (csv) can be imported using the Import Wizard and can be from any program
such as excel or Expert Estimate that create this type of data. You can also copy data onto the
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clipboard (ctrl+c) from a program like excel.

Hierarchical data
Hierarchical data is produced from civil pro for copying between projects and is used when data
contains multiple levels - for example an ITP which has to record a list of ITPs, the line items for
each ITP and then the testing for each line item. Imports of this nature do not occur very often and
are described in the registers in which they are found i.e. ITP register, Test Method register.

Importing from other databases
Importing between projects is relatively simple but there are a couple of tricks. Please refer to the
sections on Backup and Restore and Transferring project data in the System Administration topic.

4.6.1 The import wizard

When starting a new project, a lot of the data you need to enter into civil pro is already available
electronically 

There will probably be a standard list of work type abbreviations your company uses - either on
other civil pro projects or for other reasons
The payment schedule is generally created as part of the tendering process
ITPs are usually maintained in base form for customization for an individual project
Test methods are also likely to be the same on different projects of the same general type
Your surveyor may have a list of control lines
The client will probably provide a list of project documents for the document register

Civil pro allows many types of information to be directly imported using a basic wizard. This wizard is
available form the context menu of any grids for which data can be imported. To access the context
menu, right click anywhere on a register's grid. 

On the first page of the wizard you will prompted for the source of the data (Fig 1). This is either data
you have copied to the clipboard or from a csv formatted file.

csv formatted files are simply files in which the values are separated by commas. These can be
generated from excel and other spreadsheet like programs, as well as from estimating programs
such as Expert Estimator. If you select this option, you will be prompted for the file before
continuing.
Civil pro can read data you have stored on the clipboard if it is in a table like format - for example if
you have selected some cells in excel or a web page and copied them 

If the first row of your data contains the headings for the columns, select the check box 'First row
contains column headings'. If this option is selected, civil pro will try and guess what data is in each
column using the headings for the next step - if not you can do it manually without difficulty.

IMPORTANT NOTE: Special characters (such as apostrophes) can be stored using many
different formats. This can lead to strange substitutions when importing data especially
when using excel csv's. When using "Save As" in excel there is a "Tools" drop down next
to the cancel button. Selecting "Web options" allows you to specify the encoding. We have
had success selecting the UTF8 option when saving, then using the Windows 1252 import
option in Civil Pro.

http://en.wikipedia.org/wiki/Comma-separated_values
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Fig 1 - Import w izard step 1

Once you have selected your data, it will be displayed in a grid (Fig 2). If you right click on the
column that contains data you want to import, you will be given a list of data that can be assigned.
Select an item from the list matching the data in the column. Repeat until you have matched the
required data.

If you want to un-assign a column, select None from the the menu instead of a data type.
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Fig 2 - Match columns to civil pro fields

When you are finished, click 'Next'. The following step confirms the tasks to be undertaken. Click
import and if your job is successful - 'Finish'. Your data is imported.

Fig 3 - Confirm jobs to run.
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4.7 Exporting data

Data can be exported from a number of registers including the work type register, area code register,
test methods register and schedule Item register, or from the project as a whole. Data is saved in
one of three types of file;

1. csv - a table like format that can be read by excel.
2. cpx - a civil pro export file used to store hierarchical data for importing into other civil pro project.

While these files are an XML format, they are not easily read by other programs, but it is possible
for a relatively skilled user to extract the information using programs such as excel.

3. cdb - civil pro database - used for copies of entire civil pro databases that can be used for backup
or as templates. You can copy to and from templates by using the "Transfer project data" option.

Where a register can be exported, the option is accessed from the grid context menu.

Data can also be exported from all reports in excel, pdf, html, text and other formats - as well as
email. 

4.8 Creating registers

Before using your new project for every day tasks like lot management, NCRs and test requests,
there are a few registers that need to be initialized. These are simply lists used by civil pro to
categorize information and group similar data together. 

Work types
Area codes
Control lines

Depending on whether you will be using civil pro for test management, you may also set up;
Test method register 
Test properties register

4.8.1 Work types

The work types register is simply a list of the different types of work executed on the project. A work
code is two characters long and is used to group similar lots together and can also be used to
create the default lot number when you create a new lot.

Adding, editing and deleting;
To edit/add information you must enable editing.
Add a new record - click on the blank row at the bottom of the list and enter the required
information (work type and description).
Edit a new record - simply change it in the grid
Delete a new row - select it and press the delete button.

Importing and exporting
To import, open the grid context menu and select the "import work type" option and complete the
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Import wizard
To export, open the grid context menu and select the "export work type" option and select a save
location.

For an overview of the more advanced features of the interface including filtering, sorting and printing -
please refer to using the Grid.

Related Items
Work types can be linked to schedule items. This can be used to restrict the number of schedule
items users must select from when adding quantities to a lot. For more information on how this
works, refer to Schedule Item Links.

To add a schedule item, double click the Schedule Items heading in the related items panel (if it is
not visible, select "show related items panel" from the context menu). A schedule item popup list will
appear. Drag the schedule items(s) you want to link onto the Schedule Item heading in the related
items panel.

The list of linked ITPs is not a direct relationship, it is inferred by an ITP and work types share link
with a schedule item and as such cannot be changed.

Fig 1. Work Type Register
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4.8.2 Control lines

The control lines register is a list of references against which lot coordinates are defined. A control
line may be

a culvert alignment, and the coordinates the length along the line
a survey line such as the centre line of a road formation, and the coordinates the length along the
formation and offsets from the line
any other definitive location to which lot coordinates can refer

Adding, editing and deleting;
To edit/add information you must enable editing.
Add a new record -  click on the blank row at the bottom of the list and enter the required
information (control line and description).
Edit a new record - simply change it in the grid
Delete a new row - select it and press the delete button.

Importing and exporting
To import, open the grid context menu and select the "import control lines" option and complete
the Import wizard
To export, open the grid context menu and select the "export control lines" option and select a
save location.

For an overview of the more advanced features of the interface including filtering, sorting and printing -
please refer to using the grid.
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4.8.3 Area codes

The area codes register is simply a list of the different areas that comprise the project. An area code
is four characters and is used to group similar lots together and also to create the default lot number
when you create a new lot.

If you do not want to break up your project into areas, create a dummy area such as GNRL for
general.

Adding, editing and deleting;
To edit/add information you must enable editing.
Add a new record -  click on the blank row at the bottom of the list and enter the required
information (area code and description).
Edit a new record - simply change it in the grid
Delete a new row - select it and press the delete button.

Importing and exporting
To import, open the grid context menu and select the "import area codes" option and complete the
Import wizard
To export, open the grid context menu and select the "export area codes" option and select a
save location.

For an overview of the more advanced features of the interface including filtering, sorting and printing -
please refer to using the Grid.
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4.8.4 Test properties

The test properties register is a list of preset property groups that can be applied to test requests.
For example, when you create a test request for a concrete pour, you may want to add the same
additional information for each request - in Fig 1, adding the group 25MPa concrete would add
properties of concrete class, number of batches, target slump, cement type etc. to the test request.

Adding, editing and deleting; property groups;
To edit/add information you must enable editing.
Add a new record - click on the blank row at the bottom of the list and enter the required
information (property group).
Edit a new record - simply change it in the grid
Delete a new row - select it and press the delete button.

Adding, editing and deleting; Test Property Fields;
Click on the "+" symbol to the left of the appropriate test property group and the test properties
form will appear (see 25MPa in Fig 1). Enter the required information (at least a Property Name
and optionally a default property value).

Importing and exporting
Import test properties - imports a civil pro export (.cpx) file containing both the test property groups
and the test properties for each group.
To export, open the grid context menu and select the export "test methods and results" option
and select a save location.

For an overview of the more advanced features of the interface including filtering, sorting and printing -
please refer to using the grid.

Fig 1 The test property group register showing test properties fields
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4.8.5 Test methods

The test methods register is a list of all the test types that can be referenced from the ITPs and the
test requests. These tests may be defined in an industry standard, listed by the client or custom to
your project.

Each test can also list the test result fields that are recorded for the test. These are required if you
intend to record your test results in civil pro.

Adding, editing and deleting; test methods;
To edit/add information you must enable editing.
Add a new record - click on the blank row at the bottom of the list and enter the required
information (test number and description - The test number must be unique).
Edit a new record - simply change it in the grid
Delete a new row - select it and press the delete button.

Adding, editing and deleting; test result fields;
Click on the "+" symbol to the left of the appropriate Test Method and the Test Result Field form
will appear (see Q308C in Fig 1). Enter a new record for each different result you want to record for
a test of that type. For example, you may record two pieces of information for a compaction test,
the relative density and moisture content - you would add these as two lines recording the result
namd, data type (number) andunit for each, or if you were recording a grading you would create a
row for each sieve size.

Importing and exporting
Import test methods only - imports data from a flat .csv file: open the grid context menu and select
the Import Test Methods option and complete the import wizard
Import test methods and results - imports a civil pro export (.cpx) file containing both the test
methods and the result fields for each method.
To export, open the grid context menu and select the "export test methods and results" option
and select a save location.

For an overview of the more advanced features of the interface including filtering, sorting and printing -
please refer to using the grid.
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Fig 1 The test register showing test result fields

4.8.6 Variation status

Each variation is assigned a status to help track progress and group similarly statused variations
together. The statuses that can be assigned to a variation are listed in the variation status register
which is a simple list of allowable statuses.

Adding, editing and deleting;
To edit/add information you must enable editing.
Add a new record - click on the blank row at the bottom of the list and enter the required
information (variation status).
Edit a new record - simply change it in the grid
Delete a new row - select it and press the delete button.

For an overview of the more advanced features of the interface including filtering, sorting and printing -
please refer to using the Grid.
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Fig 1 Variation Status Register

4.8.7 Constants

Civil pro has a register of constants that are used by civil pro for variation project functions. These
constants are maintained in the Constants register. Any function requiring adjustment to constants
will explain what constants are required and what their value should be. 

The most common example of a constant is the LotNoDef constant which, when set, allows user
customized lot numbering. Refer to the section on lot numbers.

Adding, editing and deleting;
To edit/add information you must enable editing.
Add a new record - click on the blank row at the bottom of the list and enter the required
information (Constant Name / Value).
Edit a new record - simply change it in the grid
Delete a new row - select it and press the delete button.

For an overview of the more advanced features of the interface including filtering, sorting and printing -
please refer to using the Grid.

Constants that can be entered to alter civil pro's behaviour are;

Function Affected Constant ID Description
Lot conformance
report

signOffText Changes the text in the lot conformance report sign off from
the default

Lot numbering LotNoDef Changes the way lot numbers are automatically generated
(refer to Lot Numbers for more details)
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ITP renumbering DisableITPProm
pt

Prevents the ITP register prompting for a revision update when
data is changed if set to value True

K value for calculation
of characteristic value

k[n] Changes the factor for a sample size of n when calculating k-
values. For example a constant ID of k5 with a value of 0.75
would change the built in factoring (of 0.675) in the cacluation
of characteristic value to 0.75.

How often civil pro
checks data currency

SlowConnectionset this constant with a value of "true" and every time civil pro
opens for this project, slow connection mode will be selected.

Colouring of lots
reflecting status

ColourCodeLotS
tatus

If you set this value to "true", lots will be coloured according
to status as either conformed (green), guaranteed (blue), open
(black) or rejected (red) by default. Can be maually turned off
in the lot regsiter from the context menu.

Grids editable by
default

EditableDefault set this constant with a value of "true" and every time civil pro
opens for this project, new registers will be editable when
opened.

Enable spell check SpellCheck set this constant with a value of "true" and spell checking will
occur. 

Automatically prompt
to unguarantee

AutoUnguarante
e

This constant prompts the user to automatically unguarantee
lots older than a set number of days. Set this constant to an
integer (i.e. 28) representing the number of days after which
lots will be unguaranteed.

Specify an alternative
list of root causes for
NCRs

NCRRootCause By adding a list of comma separated values, the default list of
NCR root causes can be overridden. The default list would be
specified by setting a value of Not Specified,Personnel or
Training,Materials,Methods or Process, Machinery or
Plant,Environmental or Conditions

Change the headings
in the checklist

qvcVerBy
qvcAppBy
qvcChkBy

By setting each or any of these values, the default headings
over the check columns in the checklist can be overridden.

These constants can be entered directly into the constants register, or alternatively by using the
splash screen which appears when the constants register is first opened or when accessed from the
context menu. The splash screen allows visual alteration to the most common options, although
some options such as k-values must still be entered manually.
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To view the currently active k-values, select "Show K-Values" from the context menu in the
constants register.

4.9 Schedule item register

The construction schedule is a list of payment items for your project including a description, the
quantity you expect to build of that item (Schedule Qty) and how much you expect to be paid for
each unit of that quantity.

While you can enter your schedule line by line, it is generally available electronically and can
therefore be imported. To import a schedule, select the 'Import schedule' option from the grid context
menu (accessed by right clicking on the main part of the grid). Refer to the section on importing data
. To insert lines into the schedule use the right click context menu as described in schedule item
operations.

When the data is imported (or entered), it is a flat unstructured file, i.e. there are no expandable or
collapsible levels (Fig 1). For simple schedules, this could be the end of the schedule configuration,
but generally you will want to add some structure to the schedule by grouping some data under
headings or reordering - (see Fig 2).

The current schedule item will be coloured red. The details for the currently selected schedule item
are shown in the detail pane at the bottom of the page. It can be closed or detached as required. If it
is closed or hidden, double clicking a schedule item will make it visible again. 

To find a schedule item, use the search box in the bottom of the related data panel on the right side
of the page. If the related items panel is hidden, you can make it visible using the Show Related
Items function from the context menu (right click on the grid)
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Fig 1 - A 'flat' schedule before structuring and reordering
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Fig 2 - A structured and formatted schedule w ith headings

4.9.1 Schedule items related data

Related data for the schedule items includes;
Quantities
Specifications
Work Types
Variations

Quantities
When you do work in a lot, you add the quantity and the schedule item to which it relates to the lot
in the lot register. The total of all quantities added to a schedule item are also shown here in the
related items for each item.

Specifications (ITPs)
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You can link one or more ITPs to each schedule item. This is one way you can reduce the number
of items you have to choose from when selecting schedule items to add to a lot - refer to Schedule
Item Links

Work Types
You can link one or more work types to each schedule item. This is one way you can reduce the
number of items you have to choose from when selecting schedule items to add to a lot - refer to 
Schedule Item Links

Variations
When you raise variations, you will also need to create a schedule item so you can be paid. This
allows users to create links between schedule and varied payment items to link to variations.

To add specifications, work types or variations, double click the heading in the related items panel (if
it is not visible, select "show related items panel" from the context menu). The specifications item
popup (or work type popup - depending on your selection) will appear. Drag the items(s) you want to
link onto the appropriate heading in the related items panel.

You cannot add lot quantities to the schedule item register. This must be completed from the lot
register.

4.9.2 Schedule item operations

The main functions available from the Schedule Items context menu are;
Enable Editing
Insert Item
Lock Structure
Schedule Manipulation
o Define Headings
o Prepend characters
o Strip leading characters

Import and Exporting Schedule Items
Show Schedule Details
Show Related Items
Grid Options

Insert Item
Inserts an item immediately below the currently selected item in the list. This function can also be
invoked by pressing the insert key.

Importing and exporting items
There are three different options for importing data into a civil pro schedule, all accessible under the
File submenu in the context menu
1. import schedule - invokes the import wizard and adds the imported items to the root of the tree
2. import schedule (as child) - invokes the import wizard and adds the imported items as children to

the currently selected node
3. import (structured) - This can only be used to import schedule created in civil pro and exported

using the export(structured) option

There are two different ways to export the schedule, both are accessible under the File submenu in
the context menu
1. export schedule - exports the currently select rows to a flat csv file (no tree structure). See 
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exporting data for more.
2. export (structure) - exports the schedule as a cpx file for importing back into civil pro using the
import(structured) option

If you want an export that reflects the structure of the file, print a schedule report and export to
excel/pdf etc. using the options in the report preview control. 

Lock Structure
Prevents the structure of the treelist from being changed through drag and drop operations. The
structure of the schedule items register is locked by default and must be unlocked before modifying
the structure.

Define Headings
Invokes the Schedule Heading Wizard

4.9.3 Creating schedule structure and re-ordering

To create levels, select one or more of the 'child' rows and drag them over the parent row, waiting for
the blue arrow. This will put the rows you dropped a level lower than the parent you dragged them
onto and allow you to expand or collapse them. There is no limit to the number of levels you can
create, though you probably want to keep it to four or less for report formatting reasons.

Alternatively, you can select a group of schedule items and indent/outdent using the ctr+[left arrow]
or ctrl+[right arrow]. This will set the selected items as children of the node above (right arrow) or,
drop them down a level [left arrow]. 

The outdent behaviour may not give the result you immediately expect because the designed
behaviour is to change the parent of the rows outdented to the same as that of their current parent,
and place them immediately after their parent row. In fig. 1, this means the selected rows (1202 and
1203) will be moved to the same level as, and with the same parent as, PROVISION FOR TRAFFIC
i.e. they are directly under Part A - Roadworks. They will become the next items at that level (Fig
2.). As you can see in the figure though, items 1201 and 1204 are above them in the schedule as
they remain children of PROVISION FOR TRAFFIC.

Fig 1. Items before outdent
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Fig 2. Items after outdent

Reordering

Reordering rows is the same process except when you drag over the parent row, hovering over the
top or bottom edge of the target row will change the drop indicator to a yellow arrow. This indicates
the item will be dropped above or below the item instead of as a child.

Please note that drag and drop and reordering is disabled when the schedule register is first opened.
To enable it de-select the Lock Structure option in the grid context menu. 

Fig 3 - A structured and formatted schedule
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4.9.4 Prepending/Stripping characters

You may want to prepend/strip characters from a set of schedule items do easily differentiate them
from similar items. For example, if you have different sections (Sections A, B, C and D for example)
which have similar works and therefore similar or the same schedule item numbers, you can easily
prepend the relevant section to the start of the schedule number.

To prepend to the start of a collection of schedule items, 
1. select the items 
2. choose "Schedule Manipulation=> Prepend characters"
3. You will be prompted to enter the character to prepend. Type in a character and check/uncheck

the box to mark whether subitems will also be altered. Then click OK
4. Where the specified schedule items have schedule numbers, these will be updated to be

preceded by the specified character(s)

Stripping characters does exactly the reverse and can be used to undo if you make a mistake.

Fig 1. The prepend character prompt

4.9.5 Creating headings

Civil pro shows headings in the schedule using different formatting. Civil pro identifies headings as
those schedule items that have no qty or rate. When your schedule is imported rows you want as
headings may not show up as such. This may be because there are zeros or non-visible characters
in the cell that were imported with the data. 

To help with this, civil pro has a wizard available by selecting "Schedule Manipulation=> Define
Headings" from the context menu of the Schedule Item Register.

The schedule heading wizard is a single page form (See Fig 1.) Select how you want to define
headings by selecting or unselecting either of the two check boxes at the top. Selecting both will
require that an item in the schedule has a zero or nothing in both the quantity and rate column.

The third checkbox defines whether civil pro subtotals child items of the heading when printing
reports. The depth of the hierarchy for which subtotaling occurs is controlled by entering a value in
the 'Limit totals to levels above:' text box which is only accessible when the 'Create subtotals for
headings' option is selected. Please note that the subtotal headings can be added independently of
the heading definitions, simply run this function again and do not select any criteria for assigning
header rows.
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Fig 1. Schedule Setting

4.9.6 Schedule Item Links

You can create links between schedule items and either ITPs or Work Types. These links allow you
to 
1. restrict the list of schedule items you need to choose your lot quantities from. You can add links

to schedule items from the specification (ITP) and  work type registers.
2. restrict the list of ITPs you need to choose from when adding checklists.

When you select lot quantities for a lot, the schedule items shown in the Schedule item selector can
be shown as;

A full list
A list of schedule items which are linked to the work type associated with the lot
A list of schedule items which are linked to the checklists associated with the lot

When you select checklists for a lot, the ITPs shown in the ITP selector can be shown as;
A full list
A list of ITPs linked to the work type associated with the lot
A list of ITPs which are linked to the schedule items linked with the lot

These links between schedule items, work types and itps can be created on an as-needs basis
using the related items panel of the work type register, schedule item register and ITP register
respectively. Alternatively the link creation can be automated if you have a list relating schedule
items, work types and itps from which the relationships can be created. Relationships can be
identified if you provide;

Schedule number OR schedule description
ITP Number OR Description
Work type code

To create links from a template, 
1. select "File=> Build Template Schedule Relationships" from the right-click context menu of the 

schedule item register. The form in Fig. 1 will be shown (without any data).
2. click either the Data=>Get template from file or Data=>Get template from clipboard or Data=>Get

template from database buttons at the bottom of the newly opened schedule item form.
Depending on your selection, you may now need to select the csv file containing your template
relationships. You can only get the template from the database if you have previously used the
option Data => Save template to database, or imported the data from a database where you have
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saved the template.
3. Right click on the column headings to identify what data is in which columns. Where there are

multiple ways to identify a column (i.e. schedule number and schedule description) you can
select only one. The best option for matching is to select the most specific and accurate column.
For example, if you match by schedule number and ITP description and you have a schedule
number 7303 with an ITP description of Concrete, this will match every ITP with the word concrete
in it to schedule item 7303 - probably not the desired effect. Alternatively, if you assign by
ITPDocnumber and Schedule Number this will specifically match only the schedule number and
document number. The different options for matching are provided to allow the formation of links
from both templates with similar details to your ITP, schedule and work types, and different
details.

In figure 1 you can see that the relationships are being made from the template using the
schedule number, work type and ITP description (from the assigned heading names)

4. Click the preview button to see what links Civil Pro will automagically create (Civil Pro includes
links that contain the template entries, not just perfect matches)

5. Click the Apply button to create the links.

You can create links 
between schedule items and ITPs, 
between schedule items and work types
Between all 3

If you want to use similar relationships between similarly numberer/named itps, schedule items and
work types you can use the context menu items in the schedule item register to create a template
based on your current relationships.
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Fig 1. Schedule item linking from a template

4.9.7 Schedule item selector

The schedule item selector appears whenever a user;
Adds/Edits a lot quantity
Adds/Edits tests for a schedule item
Selects schedule items in the lot quantity page
Adds links to work types and itps

Generally, you will select your schedule items and drag them to their destination (for example the
Quantities heading in the lot related items register). Some functions can be completed by double
clicking the schedule item.
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Fig 1. The schedule item selector

When the schedule selector is invoked from a lot the items shown in the schedule selector are
either;

The full list (All schedule items)
The schedule items linked to ITPs connected to the lot as checklists (ITP Linked)
The schedule items linked to the lot's work type (Work Type Linked)

When invoked  to select a schedule item for a test (from the test request register or wizard), the
restrictions are based on the test request lot. In other cases, only the full list is shown and filtering
options are not available.

The search/filter pane can be navigated using either the mouse or the ctrl + s key shortcut. The first
keypress of ctrl+s will focus the search box. Subsequent ctr+s keypresses will change the applied
filter (unless it is disabled). 

Entering a search term will allow you to scan through the schedule for all entries with a particular
search term using the next/prev buttons.

The collapse and expand buttons toggle the view stated of the schedule item list to show all data or
just the top level.

The context toggle is used when a filter is applied to show;
Linked Items Only - only the actual item that is linked to the work type/itp for filtering
Items in context - the item that is linked plus its parent items in the schedule hierarchy
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4.10 User and personnel management

There are two types of personnel records maintained in civil pro. 
1. Users (Accessed from the Users option in the Application Menu) - Users are system wide records

of people who may access one or multiple projects in a civil pro system.
2. People (Accessed from the People option in the Setup section of the system menu)- These are

personnel who may be assigned responsibility for items in civil pro or may have documentation
otherwise associated with them but who do not require a log in. People are project specific.

4.10.1 Access control

Access to civil pro is controlled by management of user accounts, accessed through the users
page. Having a log in alone however, does not provide access to a project. Unless the login in is
designated as a System Administrator, you must be explicitly granted a role in each project the user
needs to access.

The different access roles in civil pro are;
1) System administrator - System administrators can access and perform all functions on any

projects
2) Project administrator - A project administrator can perform all functions (including assigning/

managing users) for a specific project
3) Project users - A project user can perform all functions in a project except;

a) User management
b) Project Administration (including data transfer)
c) Deleting records

For more information on managing user, refer to the users section.

4.10.2 People

The People register is a project specific list of persons to whom civil pro tasks can be assigned and
records addressed. For example, you may want to send an NCR to Michael Rogerson - this person
would need a record in the People register. Alternatively Simon Smith may be a foreman assigned
responsibility for a lot - he too would be added to the people register.

If however, Peter Jones was responsible for some lots and was also expected to update the records
in civil pro, he would need a log on and so, would become a user. Users are also included in lists of
people for a project, if they have permissions for the project or are a sysadmin.

The reason People and Users are separated is to prevent congestion of the list of people available in
drop down lists for each project. An extraordinarily large list of people can become associated with a
large project and they are of absolutely no interest to other civil pro projects. Keeping the People list
project specific means multi-project civil pro installs can each have their own list of associated
personnel (people) while maintaining a common Users register (users).

Adding, editing and deleting people;
To edit/add information you must enable editing. It is important to recognize that even with editing
enabled people who are also users on other projects, or sysadmins, can only be edited by other
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sysadmins. 
Add a new person, click on the "add person" button at the bottom of the screen, or enter their
details directly into a new row of the grid. If entering details into the grid, you will only be able to
add the basics such as name and company here (unless you use the grid heading context menu
to add more columns). Additional information such as address etc. can be added using the detail
panel at the bottom of the page. If you click the "add person" button, you will be presented with
the same form as that used for the new user wizard, except without the credentials.
Edit a new record - simply change it in the grid or detail panel
Delete a person - Click on the Delete Person button at the bottom of the page.

Fig 1 - The People register

Changing status from 'people' to 'user'

Using the context menu, you can promote a person to a user. Right click on the grid to access the
context menu, then click on "Grant Login". If you have the appropriate permissions (Sys Admin or
Project Administrator for the current project) you will be prompted to provide a username, password
and role for the new user. The user will now be able to log in and work on the project. Management
of the user can then only be undertaken in the user page.
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4.10.3 Users

People who can log in to civil pro are called users. In a standalone system, each civil pro project has
its own file so the differences between users and people end there. In a server based civil pro
system, each civil pro database can have numerous projects and more differences between users
and people are evident. In a server system, the users are common to all projects, that is a user can
use the same user account to access all projects, as long as they have the appropriate permissions
. 

The user page is accessed from civil pro's top menu. To manage users, you need to understand civil
pro's access control model.

Adding, editing and deleting users;
Click on the "add user" button at the bottom of the screen and follow the New User wizard. 
Edit a user - simply change it in the grid or detail panel
Delete a user - Click on the "delete user" button at the bottom of the page. 

To add or delete a user you must be either a System Administrator or Project Administrator. If you
only have user level permissions on the current project, you can edit your own details (including
changing your password) but not others.

Fig 1 - The User register

Changing status from 'user' to 'people'

Using the context menu, you can demote a user to a person. This will remove their login and;
If they have access to a single project, they will be assigned to that project
If they have access to multiple projects, a copy of the user will be created for each project and the
original user account will be deleted. Any references to the user in each project will be changed to
the new users in the appropriate project.
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Changing passwords'

Click on the "Change Password" button at the bottom of the User page, and enter the old and new
passwords in the popup form.

4.10.3.1 New user wizard

Upon clicking the "add user" button on the user form, the new user wizard will open. Fill out the
required (yellow) fields on the first page and click "next".

Fig 1 -  New User Wizard - Pg1

None of the fields on the second page are compulsory, but can be completed to provide additional
information.
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Fig 2 - New User Wizard - Pg2

Upon completing the user wizard, provide the user with appropriate project permissions using the 
user roles form accessed by selecting the user and clicking on the "roles" button at the bottom of
the user page.

4.10.3.2 User roles

Each user (that is not a sysadmin) must be explicitly granted permissions for a project before they
can access it. Permissions for projects (refer to Access Control) are managed in the user roles form
accessed by clicking on the "roles" button on the users form. Sysadmin users can grant and revoke
permissions to any project. Project administrators can control permissions for only the projects for
which they have administrator permissions.

Adding, editing and deleting; user roles;
To add a user role, enter a new row, select a role and a project. Click close, or progress to
another row. Sysadmins will get a list of all projects in the system, project admins will get a list of
those projects for which they are granted admin permission.
Edit a user role - simply change it in the grid 
Delete a user role - use the "delete role" option in the context menu.
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Fig 1 -  The user roles form
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5 Using civil pro

This section describes the day to day use of civil pro to manage your project. This assumes you
have completed the steps outlined previously, most notably "Setting up Civil Pro"

5.1 Log in

When you first open civil pro, you will see the main application window overlaid with the Log In
screen. You cannot use civil pro until you log in to an existing project, or create and log in to a new
one. 

To log in to;
the most recently used (MRU) project (listed under Current Connection in the large grey
box near the bottom of the login form), enter a valid user name and password for the project
and click "log in". 
a project you have recently used, click on the "Select Connection" button and select the
desired connection from the MRU file list (Fig 2 below).
a project you have not previously accessed, or a new project click on the "Select
Connection" button and select the "New Connection" button (Fig 2 below).

For more information refer to connecting to an existing project and creating a new project.

\
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Fig 1 The civil pro log in screen.

Fig 2 The MRU list

5.2 Lot register

The lot register is the main repository of information in the entire civil pro system. It contains a list of
lots and their complete definitions. Using the lot register you can also easily see what other items
are linked to each lot through the related items panel on the right. The Lot Register is a standard
register with the main grid in the center, related items on the right and the detail for each record in a
hidden panel that is made visible using by double clicking a record or using the context menu option.

Before adding a new lot, you need to ensure you have created at least one entry in the work type,
area code and control line registers. To create a new lot, click on the "new lot" button at the bottom
right of the register and complete the new lot wizard. The Lot register is accessed from the main
menu.
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Fig 1 The lot register showing the detail register.

Lot Definition
The concept of a lot is explained in the lot based QA primer at the beginning of the help file. A civil
pro lot record consists of the following (compulsory fields are marked with and asterisk (*);

Lot number * Any unique identifier. By default is created from the work type, area
code and an auto generated index.

Work type * Two letter work code describing the main work undertaken in the lot

Area code * Four letter code identifying where the lot is located

Description * A text description of the work included in the lot

Raised by * The person who raised the lot

Status The lot status - this property is read only and calculated from the
guaranteed date and conformed date as described in the topic lot
status

Geometry

    Control line * The control line to which the chainage and offsets refer

    Chainage start /
Chainage end

The longitudinal reference of distance along the control line where
the lot begins / ends

    Start left OS / Start
right OS 

The lateral distance from the control line to each edge of the lot at
the start chainage. When facing direct of increasing chainage, a
distance left of the control line is negative, while right is positive.

    End left OS / End The lateral distance from the control line to each edge of the lot at
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right OS the end chainage. When facing direct of increasing chainage, a
distance left of the control line is negative, while right is positive

Date opened * / closed The date the lot was opened / closed

Date work start / end The date work physically started/ended on a lot

Date guaranteed  If a lot complies with the specification but is waiting on some
results of testing (such as 28 day concrete tests) or other
information, then it can be given the status 'guaranteed' by
assigning a Guaranteed Date. This may be an important part of
demonstrating compliance for the purpose of payment under some
contracts.

Date conformed A conforming lot can be give a 'Conformed Date'. Lots with a
conformed date are given the status conformed

Conformed by The person who conformed the lot

Level of testing Some contracts allow a reduced level of testing once it is
established that testing processes are effective. Depending on the
ITP definition a lot with a reduced level of testing property will
generally have less tests specified in the Test Schedule.

Percent complete If a lot is open (neither guranteed or conformed), the percent
complete will be used to ratio any quantities claimed in the
progress claim

RL1 / RL 2 1 or both of these can be assigned to give a 3D definition to the lot.
While the field is labeled RL - a survey term for Reduced Level, any
vertical reference point can be used such as a landmark or a
distance to a known level (i.e. FL -0.4m)

Depth The thickness (in mm) of the lot. Used for calculating volumes.

Length, Area, Volume Properties of the lot calculated automatically from the lot geometry.
If the value for these differs to the calculated value on account of
odd shaped lots or other reasons, these can be manually assigned

Notes A text field for comments

Related Items
Each lot can have different records associated with it including checklists, NCRs, ATP, Quantities,
Other Lots and Variations. These associations can be easily created by double clicking on the
appropriate heading in the related items list. A list will pop up with all of the records of that type (If
you double clicked the NCR heading, it would show the NCR list) - simply drag the items you want
onto the related items list. To quickly go to a related item, double click it in the list i.e. double
clicking NCR 2 in Fig 1. would open the NCR register and select NCR 2. For more information on the
related items list as it applies to the Lot register refer to the sub-topic related items.

Related quantities can be adjusted by double clicking or right clicking on the quantity and
completing the popup form. Refer to the topic on Lot quantities.

You can add new items relating to a current lot by right clicking the lot and selecting "new related
item => new test request" (or atp / ncr). This will start the new test request/NCR/ATP wizard based
on the current lot.

Check lists
Using the related items  list to associate a lot with a checklist creates a copy of the checklist
specific to the current lot. The checklist can be accessed by double clicking it in the related items
list. For more refer to the topic on checklists.
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Quantities
Adding quantities in civil pro is as simple as double clicking on the quantities item in the related
items  list, selecting the schedule items you want and dropping them on the related items list. This
will add a new quantity to the lot with a schedule quantity of zero. To edit the quantities, double click
on them and they will be opened in the quantities editing pane (see fig 2.). Alternatively, you can
open the quantities pane using the context menu (right click on the lot register) and entering the
quantities directly. Quantities are explained in detail in the lot quantities help topic.

Fig 2 The Lot Register showing the quantity register.

Views
There are different columns you may want to see in the register to those presented by default. Civil
pro allows you to easily change between a set of pre-defined view using options in the grid context
menu. The available views are;

Standard Displays the default register - lot number, description, date open, ch. start, ch.
end and status

Dates Register shows the lot number, description, date open, date guaranteed, date
conformed, date work started & end, date closed

Values Shows the standard view with additional columns for lot value and lot reduced
payment value

Work in
Progress

Shows the standard view with an extra column for % complete. Only lots with
status "Open" are displayed

NCR Value Shows the values view but filters it to only show lots with an NCR

Additional Properties
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Civil pro also calculates some additional properties from the lot's properties and related items. These
properties can be shown in the grid (and therefore a printed report) by selecting the different views or
by accessing the grid header context menu (right click on the grey column headers) and selecting
the "column chooser". Additional properties are;

Has NCR? Selected if the lot has an NCR - show this column and apply a filter to show
only those lots with NCRs

Has qty? Selected if the lot has a quantity - show this column and apply a filter to show
those lots without quantities to see if any are in error

Has Doc? Selected if the lot has a document attached - show this column and apply a
filter to show only those lots with attached documents

Is parent lot? Selected if this lot has sub-lots

Is sub lot? Selected if this lot is a sub-lot

Is replaced ? Selected if this lot has been replaced by another

Is replacement
?

Selected if this lot is a replacement for another lot

Lot value The total value of quantities assigned to this lot (not factored for reduced
payment factors or % complete). Selecting this column and the Has NCR?
column and filtering to only show NCRs will allow a report on the value of lots
subject to NCRs. 

Lot red. pay
val.

The total value of reduced payment applied to each lot and % complete

5.2.1 Lot numbers

Civil pro 8 now offers customizable lot number templates. This means that when you open a new lot,
the lot number civil pro creates for you can be changed. By default civil pro creates a nine digit lot
number based on the work type, area code and an autoincrementing index (WWAAAAIII). 

For example, the third lot raised with work type SG and area MC01 will be labeled SGMC01003
using these default settings. Examples of custom lot numbers are shown below in tables 1 and 2.

Civil pro allows you to change this by specifying a new constant with the name "LotNoDef" (add a
constant as shown on the constants register). The value for the Constant defines how your lot
number appears and accepts the following;

#W = the lot's work type
#A = the lot's area code
#I = an auto increment index
| separates elements of the lot number
<sometext> literal text
(<int>) an integer defining how many characters to print for each lot property (work type/area code/
index)

For example, the default lot behaviour is defined by the LotNoDef "#W(2)|#A(4)|#I(3)".
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Fig 1: The constants page showing a custom lot definition as per the last example in table 2

Table 1: Sample data for the lots shown in table 2

ID (not a lot property)  Work Type Area Code
1 SG MC00
2 SG MC00
3 SG MC01
4 EX MC00
5 EM MC01

Table 2: Sample custom lot definitions, and the resulting lots using data from table 1

LotNoDef String Lot Numbers

#W(2)|#A(4)|#I(3) - Default SGMC000001,SGMC000002,SGMC010001,EXMC000001,
EMMC010001

myLot|#I(4) myLot0001, myLot0002, myLot0003, myLot0004, myLot0005

#W(2)|#I(2) SG01,SG02,SG03,EX01,EM01

#A(2)|#I(2) - Not a definition you
would use, for example only

MC01,MC02,MC03,MC04,MC05

Lot|#W|#I(4) - As per Fig 1 LotSG0001,LotSG0002,LotSG0003,LotEX0001,LotEM0001
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5.2.2 Lot status

Civil pro lots can have one of four statuses - Open, Rejected Guaranteed or Conformed.

Conformed Lot
A conformed lot is a lot for which all testing has been performed and results received demonstrating
compliance, all checklists are completed and any NCRs are closed out.

Guaranteed Lot
A guaranteed lot is completed and complies with the specification but is waiting on some results of
testing (such as 28 day concrete tests) or other information.

Open Lot
A lot which is neither conformed or guaranteed

Rejected Lot
When a lot is explicitly marked as rejected

Statusing a lot
A lot is 

conformed if it has a value for Date Conformed
guaranteed if it has a value for Date Guaranteed but no value for Date Conformed
open lots have neither a Date Conformed or Date Guaranteed

Multiple lots can be rejected, un-rejected, guaranteed, un-guaranteed, conformed or un-conformed by
using the functions available from the grid context menu (right click on the grid). For example, to
guarantee 5 lots, select them (multi - select using the shft or ctrl keys), right click to get the context
menu and select "Guarantee" from the menu.

You will be prompted to reject/un-reject a lot if you assign replacement lots.

5.2.3 Lot detail

The lot detail panel (shown in Fig 1.) is displayed at the bottom of the lot register. It is hidden by
default but can be shown by double clicking any lot record or selecting the "show lot details" option
from the grid context menu. To increase the screen area available to display the lot register grid,
simply close or hide the panel using the blue buttons in the top right. When the mouse is over the
buttons, the right one will show a cross - click to close, the left one will show a pin - clicking it
toggles between autohide and fixed positioning.

Fig 1 Lot Detail panel showing the Properties 
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The lot detail page shows all of the available information for a single record and changes as you
navigate to a different lot in the register. The form is editable by default, except for the Lot Number.
The lot number can only be edited after selecting 'edit lot number' from the detail panel context menu
.

The right hand side of the detail panel displays groups of information depending on the selected tab
(key dates, geometry, properties or notes).

Properties (incl Lot Length, Area and Volume)
In the Properties tab, (Fig 1) you can select the geometry type. This determines how the lot extents
are determined. Refer to the lot wizard for more information. 

The values for lot length, area and volume are also displayed. These are calculated automatically
and will be updated whenever you change the geometry (for lots with chainage geometry or
coordinate position). If the calculated values do not reflect the actual values for the lot due to an
irregular shape not captured by the lot definition, you can overwrite them. This will prevent the values
being calculated automatically unless you reverse the manual assignment. To manually override the
AVL (area, volume, length) select "AVL override" from the detail panel context menu. When a
chainage position coordinate type is selected, an area will be calculated, and if there are only two
points then a length is calculated. 

Fig 2a) Lot Detail panel - Control Line geometry

Fig 2b) Coordinate Position or Region geometry

For more information on the information stored for each lot, refer to the lot register.
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5.2.4 Lot quantities

Lot quantities are visible in two locations on the lot register. The first is in the related items panel
(Fig 1), the second is in the lot quantity panel (Fig 3).

Related Items Panel
The related items panel shows the quantities registered against the lot currently selected in the grid.
It is useful for quickly seeing what quantities are registered against lots, but also for quickly adding
new quantities and deleting old ones. To add a new quantity, double click on the quantities heading
on the related items panel - a popup displaying schedule items will appear (Fig 2). Drag the
schedule item(s) you want onto the quantities heading and drop them. They will be assigned a zero
quantity. To update the quantity, double click it and the Quantities panel will appear at the bottom of
the page where the Lot Detail page appears.

TIP: 
1. You can also add a single quantity to the currently selected lot by double clicking it instead of
dragging it.
2. Right clicking a quantity from the related items list opens a dialog box where you can edit the
quantity.

To delete a quantity using the related items list, select the quantity and press the delete key.

Fig 1 - Related Items 

The popup for schedule items. Refer to Schedule item selector
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Fig 2. The schedule item selection panel

Lot Quantity Panel
The lot quantity panel can be accessed by double clicking a quantity or by selecting "show lot
quantities" from the grid context menu. While quantities are most easily assigned using the drag
and drop described above, they can also be added directly into the grid using a new row with the
appropriate details.

Fig 3. The Lot Quantity Panel

Lot quantity records consist of;

Schedule Item The schedule item to which the quantity refers. This schedule item will be
used to get the rate and unit used to calculate the progress claim and lot
values

Quantity The quantity of work complete for the item selected in the schedule

Unit The unit for this quantity - defaults to the schedule item unit
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% Complete The percentage of work complete - defaults to 100% but can be adjusted
independently of the lot % complete where different pqyment items for the
same lot are in different stages of completion

Preliminary Selected if the quantity is a preliminary quantity

Non Claimable Selected if this quantity is not to be included in the progress claim. You may
use this to register a quantity for calculating testing but not for payment.

Comments A text field for any comments

RPF Reduced Payment Factor: Some contracts allow acceptance of non-
conforming work in exchange for a reduction in payment. 

NCR# Hidden: Any NCR relevant to this schedule quantity

VRN# Hidden: Any VRN relevant to this schedule quantity

# Both the NCR and VRN columns are hidden by default. They are easily made visible by accessing
the Quantity grid context menu (right click on the qty grid) and selecting
Views => Quantity NCR / VRN.

5.2.5 Lot documents

You can attach documents of any kind to a lot - including spreadsheets, word documents, pdfs or
images. Related documents are shown in the related items panel under the heading "Documents".
Before adding an documents (or photos) you must have the project file path set up. Refer to the
topic Project administration

To add a document, simply select the lot you want to add the document too, and double click on the
"Documents" heading. In the file selector dialog, select the file and click "Open". You will be
prompted to update the description (Fig 3.) which defaults to the file name. When ready, click on
"OK". The document will now appear under the "Documents" heading for the lot.

Fig 1.  The lot document editor

Viewing Lot Documents

To view a lot document, double click it and civil pro will open it using the default program for the file
type of the lot document. Civil Pro cannot open documents that do not have an associated program.

Printing Lot Documents
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To print a lot document, right click it to get the context menu, and select the print option.

Editing Lot Document Records

To change the file a lot document refers to, or to update the description of the lot document, right
click on it and selecte the edit option from the context menu.

Testing Documents

Lot Documents can also be added in the Test Request register. This is used for recording copies of
test reports from testing authorities. Any document added to a test request is also listed in the Lot
Documents for the lot tested on the test request.

5.2.6 Related items

The related items panel allows users to quickly see information associated with a lot. It is also the
quickest (and sometimes only) way to create associations between lots and other registers, or
between lots.

Fig 1. The related items panel

Quantities
To create a new quantity, double click on the "quantities" heading - a schedule list will pop up.
Select the schedule item(s) you want and drag/drop them onto the quantities heading. If you can't
find your schedule item, you can use the search facility at the bottom left of the schedule popup
panel. Type in the string you want and click the "<" or ">" buttons to move through the instances
present in your list. The search is exact match, meaning that if you type in "Seal", civil pro will find
schedule item beginning with Seal. If you want to find all items containing Seal anywhere in the
description, you need to prefix it with a question mark i.e. enter "?Seal". In the example in Fig 2, the
search for "?amc" returned four hits.
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After adding quantities you can see more detail by double clicking the relevant quantity. To delete,
select the quantities to delete and press delete. For more detail on quantities refer to Lot Quantities.

Fig 2. The schedule item selection panel

Checklists
To create a new checklist for a lot, double click on the "checklists" heading - a list of ITPs will pop
up. Select the ITP(s) you want and drag them onto the checklists heading. To view the checklist,
double click it. To delete a checklist, select it and press "Delete". For more information on
Checklists, see lot checklists

ATPs, Variations, Photos and NCRs
Links between registers are shown in the related items list (refer NCR 2 in Fig 1 above). To add a
new link, double click the relevant heading and a list of available ATPs/Variations/NCRs or photos
will pop up. Select the desired items and drag and drop them on the appropriate heading. Double
clicking on an item (i.e. NCR 2 above) will take you to that record in its register. To delete a link,
select it and click delete - this will not delete the item, just the link between it and the lot.

Test Requests
Links between test requests and lots cannot be create using the related items register. This is
because when a test request is created, it is assigned a lot and can only have one lot assigned to it.
You cannot delete a link to a test request, because the reference is to the test request itself. If you
need to remove an association between a test request and a lot, go to the test request (double click
on it) and change the lot it is associated with, or delete the test request as appropriate.

Documents
Civil Pro can attach any electronic file to your lots. For more details refer to the topic Lot Documents
.
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Related Lots
Lots can be related in two ways, one lot may replace another, or it may be a child lot (or have child
lots). To establish either, double click the "related lots" heading - a list of lots will pop up. Select the
lot you want to relate to the current lot and drag it onto either the "replaced by", "replaces", "parent
of" or "child lot of" headings.

If you have Lot A selected in the grid, double clicking related lots and dragging Lot B onto the Child
of heading will result in Lot B becoming a child lot of Lot A. If you then select Lot B in the lot register
instead of Lot A, you will see that Lot A is listed in the related items as a Parent Lot for Lot B.
Similarly if Lot C Replaces Lot D, navigating to Lot D will indicate that it is Replaced By Lot C.

When you replace lots, you will be prompted as to whether you want to mark the lot as rejected.
Rejected lots do not contribute to progress claims and are statused accordingly

5.2.7 New lot wizard

The new lot wizard simplifies the creation of a new lot by undertaking the task step by step. To
access the new lot wizard, click on the New Lot button on the bottom of the Lot Register.

TIP: Holding down the shift key while clicking on the new lot button will start the new lot wizard using
the currently selected lot as a template. Alternatively you can use the New Lot (like selected) option
from the context menu.

Step 1. Select an Area Code, Work Type and Description. The Description is compulsory.

Fig 1: New lot step 1 1 - work type, area code and description
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Step 2. Enter the person raising the lot, the date the lot was opened and optionally the date that
work started on the lot. Also specify if the level of testing is reduced.

Civil pro will recommend a lot number based on either the default lot number definition, or as in the
case below, a user defined lot number definition. Most of the time this can be left as is.

In this step you also decide how the lot's position will be defined. Select from;
1. No Geometry - Sufficient information to describe the lot is contained in the description and no

additional information is required
2. Chainage - The lot is defined by chainage / offset / RL
3. Coordinate Position - the lot contains features that identified by a series of coordinate positions x,

y,z
4. Coordinate Region - the lot is a region bounded a series of points for which coordinates are

provided as x,y,z

Fig 2: New lot step 2

Step 3. (Not required for No Geometry)

1. No Geometry - Not Used
2. For chainage geometry enter the details of the lot geometry including the control line, chainage

details and offsets (Fig 3a).
3. For coordinate position, enter the x,y,z coordinates for each feature (Fig 3b).
4. For each coordinate defining the region, enter its x,y,z (Fig 3b).
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Fig 3a: New lot step 3

Fig 3b: New lot step 3

Step 4. Lot Calculations are performed and the results displayed on this page. If you want to used
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different values to those automatically calculated, click on AVL override and enter the values you
want.

Fig 4: New lot step 4

Step 5. The final page summarizes the information you have entered so you can confirm prior to
committing the new record. If you are happy with the information, click on Finish. If at any point you
want to revise your information, you can click on the back button in the top left corner.
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Fig 5: New lot step 5

5.2.8 Lot checklists

A checklist is a list of items requiring verification during the execution of the work associated with a
lot. Civil pro creates templates for checklists as part of the Specification/Inspection Test Planning
process. 

Lot checklists are customized copies of the template checklists. To create a new checklist for a lot;
Double click the "checklists" heading in the related items
Select one or more ITP/Checklist's and drag and drop onto the checklists heading in the related
items list
Your new checklist(s) will be added to the lot.

to view this, or any other checklist, double click on the checklist in the Related Items list. An
example of a the checklist form that appears is shown in Fig 1.
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Fig 1 Embankment Checklist for lot EPGNRL007

The checklist can be printed and manually completed in the field, or it can be completed
electronically. 

Check, Verification and Approval
Civil pro allows you to specify three different levels of inspection. For example, you may require that
a field supervisor check some items, a site engineer verify others and that approval is required for
key items (probably from the client). The inspection level of each line is defined when the template
for the ITP is created. In Fig 1 all except 2 items require the supervisor to 'check' work, most require
the engineer to verify (except rows 1,3,7 & 13) and the Client's approval is required for the 8th item.

Once the checklist is completed, you can complete the information recording who checked, verified
and approved it and when (top right), or alternatively you can leave it blank and manage it all with
printed hard copies.

5.2.9 Conformance reports

When a lot is completed and all of the data compiled, it is often necessary to create a printed report
summarizing the lot. To create this "conformance report", select one or more lots and click on the
"conformance report" button in the "reports" menu at the bottom of the lot register. You will be
presented with a report similar to that shown in Fig 1. If you have more than one lot selected, they
will all be compiled into a single document with a page break in between.

It is important to notice that there are two different tabs in the print preview header for the
conformance report. The first (not shown) is the standard print preview menu - visible in Fig 1 of the 
print preview help topic. The second dictates what is included in the conformance report.

To include or remove information from a report, ensure it is checked/unchecked appropriately and
click on the "update" button in the top right. If you click on the "make default" button, then your
current options are recorded for when you print a conformance report in the future (for system or
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project administrators only - project wide setting).

Fig 1: Conformance report

5.2.10 Test schedules

If you assign a checklist to a lot, civil pro can use your checklist to create a test schedule. The test
schedule is a list of the tests required for a lot's conformance and is created using any checklists
assigned to a lot, and each lot's properties. Fig 1 shows the test schedule for a lot to which an
embankment checklist is assigned. 

All of the tests assigned to the checklist ITP are collated in the test schedule (refer to the ITP
register). To calculate the number of tests required, the "qty for calc" column must be set by
enabling editing and selecting an option from the list of different quantities. Fig 1 shows the test
schedule prior to assignment and without test quantities. Fig 2 shows the same test schedule after
assigning the quantity basis and calculating tests. To make it easier, you can select multiple rows
with the same quantity basis and use the bulk assign show expanded in fig 1 below.

You will notice as you assign a quantity basis, the "calc tests" column is automatically updated with
a required number of tests based on the assigned qty/freq, or the minimum no of tests, depending
on which is greater. Once every line you will test has quantity basis assigned to it, you can use the
"set no. of tests from calc" function from the context menu. This assigns the actual planned number
of tests (in the "no. tests' column) using the "calc tests" theoretical value. If you need to vary the
number of planned tests from that calculated, simply enable editing and change it as has been done
for Q110A in Fig 2.
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Or sets and optional tests
You will also notice that Q111A is coloured green. This is because it is part of an "or set". An or set
is created when there are two different options for testing - this may be the case when you can use a
nuclear densometer OR a sand replacement test to measure density. The default member of the or
set will be shown when you first display the test schedule. To change which member of the or set is
selected, double click the row and all options will be visible, double click the test you want to use
and the others will disappear. You can make and undo or sets using the context menu - this is the
same as described in the ITP help topic.

Tests can also be marked optional. Optional tests are coloured grey/blue (there are none of these in
Fig 1, but Q113A is assigned as optional in Fig 2). Tests can be marked/unmarked using the
options in the right click context menu.

 Any changes to an or set or optional test are not reflected in the master ITP definitions.

Reports
Your test schedule can either be printed as its own report, or you can simply use the checklist
which will be update to display the number of tests you have assigned for each test.

Fig 1 - A test schedule prior to assignment of qty basis for calculating required tests. The available

options for quantities are shown in the pop up (bottom left)
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Fig 2 - The test schedule after assigning qty basis and setting the no. tests. Note the new optional test

Q113A

5.3 Non conformance

The non conformance report register (NCR register) is used to record products or processes that are
not completed in accordance with the project specifications. Recording non-conformances, how the
non-conformances are resolved and methods for preventing reoccurrence are central to any project
and indeed any business.

The NCR register is accessed from the main menu and consists of the main grid, related items
panel and detail panel. Changing the selected item in the grid will change the list of related items
and the record shown in the detail pane (if visible). To see the NCR detail page (hidden by default)
double click on an NCR or select the "show NCR detail" option from the context menu (right click
the grid).

New NCRs are created using the NCR wizard - accessed from the "New NCR" button in the bottom
left of the page. 
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Fig 1. The Non Conformance Report Register

NCR records

A NCR record consists of;
A description of the issue
How it will be fixed or otherwise managed
What lots this affects
Approvals
Close out

The full list of information that can be recorded against an NCR is;

NCR No. * A sequential number for each project - generated automatically by civil pro

Description * A description of the non-conformance

Location Where the non-conformance is located

Corrective
action

How will the non-conformance be resolved? 

Preventative
action

What steps will be taken to prevent reoccurrence?

Action type An item in the preset list of the course of action adopted - includes retest,
reject, repair/rectify, use as is, replace/reconstruct or other (refer to
disposition)

Raised by * The person who identified the NCR

Date raised * The date the NCR was raised

Related parties Any third parties associate with the NCR - i.e. subcontractors or suppliers

3rd party Is third party approval - say by the client - required
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approval req'd

Severity How severe is the NCR - is it only incidental or is its impact only minor, or is
it major.

Approved by Who has approved the disposition and agreed that the proposed actions will
resolve the non-conformance

Date approved The date approval was granted

Approval
remarks

Any comments or conditions relating to the approval

Closed out by Who has checked that the steps outlined in the disposition were completed

Date closed out When was successful completion of actions for this NCR verified

Closeout
remarks

Any comments on the Close Out process

Root Cause What was the key contributor to the NCR. By default the options are  Not
Specified,Personnel or Training,Materials,Methods or Process,
Machinery or Plant,Environmental or Conditions but can be
customized by setting the appropriate constant

NCR Cost The cost of rectifying the NCR. These differ from the fields visible in the grid
under the Values view (refer below) which show the value of work attributed to
lots linked to the NCR. The cost is not displayed on the NCR.

Notes Any general text relating to this NCR

Views
There are different columns you may want to see in the register to those presented by default. Civil
pro allows you to easily change between a set of pre-defined view using options in the grid context
menu. The available views are;

Standard Displays the default register - NCR number, description, disposition, date
raised and status

Values Shows the standard view with additional columns for lot value and lot reduced
payment value

Approval Shows the NCR no, description, approval remarks, approved by, date approved
and status columns

Close out Shows the NCR no, description, close out remarks, closed out by, date closed
out and status columns

Classification Shows the NCR no, description, severity and action type

Additional Properties
Civil pro also calculates some additional properties from the NCR's properties and related items.
These properties can be shown in the grid (and therefore a printed report) by selecting the value view
from the context menu or by accessing the grid header context menu (right click on the grey column
headers) and selecting the "Column chooser". Additional properties are;

Lot value The value of lots associated with this NCR

Reduced
payment value 

The value of reduced payments applied to a lot.

Additional Properties
The NCR register can be filtered by lot by selecting a lot from the drop down list present in the NCR 
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grid context menu.

5.3.1 NCR detail

The NCR detail panel (shown in Fig 1.) is displayed at the bottom of the NCR register. It is hidden by
default but can be shown by double clicking any NCR record or selecting the "show NCR details"
option from the grid context menu. To create more real estate to view the grid, simply close or hide
the detail panel using the blue buttons in the top right. When the mouse is over the buttons, the right
one will show a cross - click to close, the left one will show a pin - clicking it toggles between auto-
hide and fixed positioning.

Fig 1 NCR Detail panel

The NCR detail page shows all of the available information for a single record and changes as you
navigate to different NCRs in the register. The form is editable by default, except for the NCR
number. The NCR number can only be edited after selecting 'edit NCR number' from the detail panel
context menu.

The right hand side of the detail panel displays groups of information depending on the selected tab
(corrective action, preventative action, action type, approval, closeout and notes).

For more information on the information stored for each NCR, refer to the NCR register.

5.3.2 Related items

The related items panel allows users to quickly see information associated with an NCR (lots and
photos). When you move between NCRs in the NCR register, the related items list will show the lots
and photos linked to the NCR.
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Fig 1. The NCR related items

To add a new link between a lot and an NCR, double click the lots heading in the related items list -
A list of lots will pop up. Select the lot(s) you want to add and drag them onto the related items list.
To see the detail of a lot, double click it and the lot register will open displaying the clicked lot. To
delete a relationship, select it and click delete.  This and similar mechanisms in the lot register are
the only way to create associations between NCRs and lots after the NCR has been created.

The related photos list shows any photographs stored in civil pro that are related to the NCR. To
associate them, follow the same procedure as for adding a lot to the NCR, but double click on the
photo heading instead.

5.3.3 New NCR

The new NCR wizard simplifies the creation of a new NCR by undertaking the task step by step. To
access the new NCR wizard, click on the "new NCR" button on the bottom of the NCR register. For
information on what information is required in each of the fields (description, disposition, date NCR
raised etc.) refer to the NCR register section.

Step 1: Enter basic NCR information including the description and disposition. Change the date
raised if required. Civil pro will assign the next available NCR no.
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.
Fig 1. New NCR wizard page 1 - basic NCR information

Step 2: Adjust the NCR categorization as required - severity, action type and approval requirements,
who raised the NCR and any related parties such as subcontractors or suppliers.



103Using civil pro

© 2014 Blue Sky Contracting P/L

Fig 2. New NCR wizard page 2 - NCR categorization

Step 3: Select lots related to your NCR. Press the tab key to assign the lot and add more if you
require.
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Fig 3. New NCR wizard page 3 - lots associated w ith this NCR

Step 4: Review the summary of the information civil pro has collected for your NCR and click "finish"
if it is OK. To correct information go back through the wizard by clicking the back arrow in the top
left of the wizard.
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Fig 4. New NCR wizard page 4 - summary

5.3.4 NCR Reports

NCR reports are hard copies of an NCR, generally generated in the approval process. To print reports
for one or more NCRs, select the required NCRs in the NCR register and click the NCR Report
button in the Reports menu at the bottom of the register.

The report will appear similar to that shown below in figure 1. Note the menu at the top of the page
for indicating whether any attached photos are included, and whether the closeout sign off is shown.
This is the second tab in the ribbon at the top of the report and not the tab shown by default
(normally you will see the standard report preview toolbar). Change options and select "Update" to
refresh the report. Press Make Default to make these options the standard view (sets for project
wide - must be sysadmin or project admin)
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Figure 1 - NCR Report w ith print options shown

5.4 Authority to proceed

The authority to proceed register (ATP register) is used to record requests to third parties for
inspections and approvals - generally in accordance with contract requirements. As well as providing
a platform for formalizing the approval process, it also provides a way of proving the timing of
requests which can be important when notification periods are required (and enforced) by the client.
If your project is proceeding in a cooperative manner then this functionality of civil pro may not be
required.

The ATP register is accessed from the main menu and consists of the main grid, related items panel
and detail panel. New ATPs are created using the ATP wizard - accessed from the "new ATP"
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button in the bottom left of the page. Changing the selected item in the ATP register will change the
list of related items and the information in the detail panel. To see the ATP detail page (hidden by
default) double click on an ATP or select the "show ATP detail" option from the context menu (right
click the grid).

Fig 1. The authority to proceed register

ATP records

The full list of information that can be recorded against an ATP is;

ATP no. * A sequential number for each project - generated automatically by civil pro

Description * A description of the individual items to inspect

Date submitted
*

The date the ATP was submitted

Time submitted The time the ATP was submitted

Requested by * The person creating the ATP

Sent to * The person to whom the ATP is addressed

Date response
required

The date a response to the ATP with approval or otherwise is expected.

Inspection
Details

Lot The lots to be inspected

Item to inspect The detail of what is to be inspected for the lot (a brief description)

Date to inspect The date the item will be ready for inspection
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Time to inspect The time the item will be ready for inspection

Approved by The person approving the item

Approval
comments

Any comments or conditions relating to the approval

Date approved The date the inspection item was approved

Views
There is only one view for the ATPs - the standard view which is the default view when the form is
opened. You can use this context menu option to return the grid to its default state after you make
changes.

5.4.1 ATP detail

The ATP detail panel (shown in Fig 1.) is displayed at the bottom of the ATP register. It is hidden by
default but can be shown by double clicking any ATP record or selecting the "show ATP details"
option from the grid context menu. To create more real estate to view the grid, simply close or hide
the detail panel using the blue buttons in the top right. When the mouse is over the buttons, the right
one will show a cross - click to close, the left one will show a pin - clicking it toggles between auto-
hide and fixed positioning.

Fig 1 ATP Detail panel

The ATP detail page shows all of the available information for a single record and changes as you
navigate to a different ATP in the register. The form is editable by default, except for the ATP
number. The ATP number can only be edited after selecting 'edit ATP number' from the detail panel
context menu.

As well as the main part of the form (ATP no, description etc.) there is a list of lot inspection items.
Each line represents a lot and an item to inspect on that lot. To add a new entry, enter information
into the blank line at the bottom of the ATP.

For more information on the information stored for each ATP, refer to the ATP register.

5.4.2 Related items

The related items panel allows users to quickly see the inspection items recorded against each
ATP. Each item under the "lots" heading reflects one of the lots for which an inspection was
requested when the ATP was created (or added after). To the right of the lot number is the
description of the Item to inspect. Under each lot is a list of the quantities for the lot.
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Fig 1. The ATP related items

To add a new inspection item to an existing ATP, double click the Lots heading in the related items
list - A list of lots will pop up. Select the lot(s) you want to add and drag them onto the related items
list. To see the detail of a lot, double click it and the lot register will open displaying the clicked lot.
To delete a relationship, select it and click delete.

After adding an inspection item by drag and drop, a new line will be added to the Inspection Items on
the ATP with the Item to Inspect field set as "TBA" - this should be edited and the date to inspect /
time to inspect field checked. You can also add new lot inspection lines through the ATP detail
page.

5.4.3 New ATP

The new ATP wizard simplifies the creation of a new ATP by undertaking the task step by step. To
access the new ATP wizard, click on the "new ATP" button on the bottom of the ATP register. For
information on what each of the fields is for (description, raised by, date submitted etc. refer to the 
ATP register section.

Step 1: Enter basic ATP information including the description of the ATP, who raised it and who it is
addressed to. Civil pro will assign the next available ATP No. The description may be anything from
an outline of the inspection items to a specification reference or even a date reference like 'Week
ending May 28th".
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Fig 1. New ATP wizard page 1 - basic ATP information

Step 2: Select the lots you want to have inspected, a description of what is to be inspected, the
date for inspection and optionally the time to inspect.

Fig 2. New ATP wizard page 2 - lots for the ATP

Step 3: Review the summary of the information civil pro has collected for your ATP and click Finish if
it is OK. To correct information go back through the wizard by clicking the back arrow in the top left
of the wizard.
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Fig 3. New ATP wizard page 3 - The ATP summary

5.5 Test requests

The test request register (TR register) is used to track any testing associated with each lot, and to
communicate this testing to testing authorities and the client.

The test request register is accessed from the main menu and consists of the main grid, related
items panel and detail panel. New TRs are created using the test request wizard - accessed from
the new test request button in the bottom left of the page. Changing the selected item in the TR
register will change the list of related items. To see the TR detail page (hidden by default) double
click on a TR or select the show TR detail option from the context menu (right click the grid).
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Fig 1. Test request register

Test Request Records

The full list of information that can be recorded against an TR is;

TR no. * A sequential number for each project - generated automatically by civil
pro

Description * A description of the tests being requested

Date requested * The date the test request was requested

Date required The date that testing is required

Lot no * The lot being tested

Requested by * The person requesting the Test Request

Test req. to The person to whom the Test Request is addressed

Test reason Either control or compliance. Control tests are generally considered to
be internal quality management tests, while compliance tests are
performed on work that has been through standard processes and is
thought to be compliant.

Geometry

    Control line * The control line to which the chainage and offsets refer

    Chainage start /
Chainage end

The longitudinal reference of distance along the control line where the
work to be tested begins / ends

    Start left OS / start The lateral distance from the control line to each edge of the test area
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right OS at the start chainage. When facing direct of increasing chainage, a
distance left of the control line is negative, while right is positive.

    End left OS / right
end OS

The lateral distance from the control line to each edge of the test area
at the end chainage. When facing direct of increasing chainage, a
distance left of the control line is negative, while right is positive

    Depth to test If the test is of a layer of material or similar work where the depth is
relevant, this field the depth in mm of the material being tested

    Level datum A vertical reference for the test - can be a landmark or an actual
survey level

Options

    Source The source of the material being tested

    Test complete? A tag to indicate if the testing under this test request has been
completed

    Test locations Specifies how the location of tests is to be determined. Either "tester
locates" (no locations specified) / "location specified" (the test
locations are explicitly assigned as part of the test request) or
"random stratified testing" (random locations are assigned to each
requested test in accordance with standard random stratified sampling
techniques)

    Test length The length of the region being tested

    Test area The area of the region being tested

    Test volume The volume of the region being tested

    Notes Any notes about the tests being requested

Test Completion Wizard
In the context menu of the test request, there is a function to run the Test Completion Wizard. This
function checks every test requested for all of the currently selected test requests (Ctrl + A to select
all TRs) and marks each test as complete if it has test results recorded against it. It subsequently
marks the test request itself complete if all of its tests are marked as complete.

If you have manually changed the status of a test request or test to "Complete", it will not be
changed by running this function.

Views
There is only one view for the test requests - the standard view which is the default view when the
form is opened. You can use this context menu option to return the grid to its default state after you
make changes.

Tests
When a test request is raised, a series of tests are specified. These tests are listed against each
test request with the test method and optionally additional information including the schedule item of
the work being tested, the control line, and a location in 3 dimensions. Refer to the section on test
request tests.

Test Properties
Test requests can have additional test properties assigned to them. For example, when you create a
test request for a concrete pour, you may want to add the same additional information for each
request - in Fig 1, adding the group 25MPa concrete would add properties of concrete class, number



114 Civil Pro Help v8.8.51

© 2014 Blue Sky Contracting P/L

of batches, target slump, cement type etc. to the test request. These can be added individually or
from a predefined list of test property groups.

5.5.1 Test request detail

The test request detail panel (shown in Fig 1.) is displayed at the bottom of the test request register.
It is hidden by default but can be shown by double clicking any test request record or selecting the
"show test request details" option from the grid context menu.  To create more real estate to view
the grid, simply close or hide the detail panel using the blue buttons in the top right. When the
mouse is over the buttons, the right one will show a cross - click to close, the left one will show a
pin - clicking it toggles between auto-hide and fixed positioning.

Fig 1 Test request detail panel

The TR detail page shows all of the available information for a single record and changes as you
navigate to different test requests in the register. The form is editable by default, except for the TR
number. The TR number can only be edited after selecting 'edit TR number' from the detail panel
context menu.

Test request length, area and volume
In the "options" tab, (Fig 1) the values for lot length, area and volume are displayed. These are
calculated automatically and will be updated whenever you change the geometry. If the calculated
values do not reflect the actual values for the test request due to an irregular shape not captured by
the lot definition, you can overwrite them. This will prevent the values being calculated automatically
unless you reverse the manual assignment. To manually override the AVL (area, volume, length)
select AVL override from the detail panel context menu.

For more information on the information stored for each TR, refer to the TR register.

5.5.2 Test request tests

Each test request has a list of tests associated with it. This list of tests is initialized when the test
request is created (using the new test request wizard) and can be viewed in the related items panel
or in the test request tests panel. The test request tests panel is accessed from the test request
grid context menu - accessed by right clicking on the test request grid.
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Fig 1 Test Request Register showing the Test Request Test panel (bottom)

Each test request test records as a minimum the test method for the test. Optionally the schedule
item, control line, 3 dimensional location and individual test completion status are recorded. The
sample no. is generated by civil pro and can be changed.

The test method is essential for each test for two reasons. The most obvious one is because it
dictates to the tester what test to perform, but it also tells civil pro what result fields will be needed if
you record the test results in the system.

5.5.3 Test properties

Each test request can have a list of properties associated with it. This list can be viewed in the
related items panel or in the test properties panel. The test properties panel is accessed from the
test request grid context menu - accessed by right clicking on the test request grid.
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Fig 1 Test request register showing the test properties panel (bottom)

Test properties can be added individually or from pre-built lists created in the test properties register.
To add items from a test register group, select the test property group from the drop down list and
click on the "add properties" button. To delete a test property, select it and press the delete button
in either the related items panel or the test properties panel.
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5.5.4 Related items

The related items panel allows users to quickly see the tests, test properties and documents
recorded against each Test Request. 

Fig 1. The test request related items

Tests and Test Properties
Test request tests and properties cannot be added or edited using the related items panel. The only
functionality available from the related items for these records, is deletion of test properties. To
delete test properties, select them and click delete.

Test request tests and properties can be added, edited and deleted using the test request tests
panel and test properties panel. These are accessed by selecting them from the grid context menu
(accessed by right clicking the grid.)

Documents

You can attach documents of any kind to a lot - including spreadsheets, word documents, pdfs or
images. Related documents are shown in the related items panel under the heading "Documents".
Before adding an documents (or photos) you must have the project file path set up. Refer to the
topic Project administration. Any documents added to a test request are also shown as related
documents for the lot referenced by the test request.

Test request documents are managed exactly the same way as Lot Documents. For more
information refer to the topic Lot Documents.
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5.5.5 New test request

The new test request wizard simplifies the creation of a new test request by undertaking the task
step by step. To access the new TR wizard, click on the "new TR" button on the bottom of the test
request register. For information on what each of the fields is for (description,  requested by, date
requested etc. refer to the test request register section.

Step 1: Enter basic information about your test request. The fields are quite self explanatory
including a description of the tests to be taken (or area to be tested) the lot to be tested, who
requested the test and when, who is responsible for organizing the actual testing and when the
testing is required.

Fig 1. Test request w izard step 1 - general test req. definitions

Step 2: This step is where the area to be tested is defined. The elements of the geometry are
explained in both the lot register and the test request register
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Fig 2. Test request w izard step 2 - test req.  geometry

Step 3: Calculations
In this step the user specifies the Material Source, who specifies the testing location and how. The
method of location field has the following impact;
1. Tester locates - No locations are specified, the tester decides where to take the tests based on

specification requirements.
2. Random stratified testing - civil pro creates random locations using random stratified sampling
3. Location specified - the person raising the test request specifies the locations

The random locations section (middle) determines which positions are calculated when random
stratified sampling is used. In Fig 3. Civil pro will calculate random positions in the longitudinal and
lateral directions, but not depth. If you were testing something like a kerb platform, you would want
civil pro to only calculate a test position longitudinally.

The resolution is the number of decimal places civil pro will calculate the location to. The default is
zero (i.e. closest metre).

The calculations values for length, area and volume are calculated automatically by civil pro unless
the AVL override checkbox is selected, in this case you can specify these values to account for
irregular shapes or other departures from the calculated values.
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Fig 3. Test request w izard step 3 - test req. calculations

Step 4: Tests
For each test you want taken, enter the test type, (optionally) the schedule item and the number of
that type of test. If civil pro is calculating the test positions it will locate tests together to minimize
the number of samples required. For example in the Fig 4, the single CBR will be located in the
same place as the first density - as is seen in Fig 5. Remember, if you need to delete a value (such
as if you accidentally selected a schedule item), close the selector and click ctrl+delete. This will
clear the editor.

Fig 4. Test request w izard step 4 - test req. tests
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Step 5: This page shows the sample locations according to the location method shown in step 3.
There is usually nothing to do here.

Fig 5. Test request w izard Step 5 - test req. samples

Step 6: Each test request can have one or more test properties. These can be entered manually or
selected from a pre-built list. In the above example, the list for 32MPa concrete was selected and
the "add properties" button pressed. The properties such as concrete class and target slump were
imported along with some default values. Check any default values are correct and update any other
values that are empty and relevant.
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Fig 6. Test request w izard step 6 - test req. properties

Step 7: Review the summary of the information civil pro has collected for your test request and click
"finish" if it is OK. To correct information go back through the wizard by clicking the back arrow in
the top left of the wizard.

Fig 7. Test request w izard step 7 - test req. summary
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5.5.6 Test results

The test results register is used to record testing outcomes from any of the test requests you
complete. To record test results, you must have set up your test methods with test result fields so
civil pro knows what results to expect.

When you first open the test results register, no test results are shown. This is as displayed in Fig
1.

Fig 1. The test result register when opened - no results shown

To show test results, select the test request(s) you want to display results for and optionally select
a test method from the drop down at the bottom of the page. Click the show tests button next to the
test method  filter (be default contains the text select test method to filter results). 

If you do not opt to filter the test results to a specific method using the test method  filter, then a
page will be created for each test method and any of your selected test requests with tests of that
type will be displayed in the appropriate page. In Fig 2. A separate page has been created for all test
methods present in the selected test requests (TR 1,2 and 3). To switch between test results for
each test method, click on the relevant page. 
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Fig 2 The test result register showing results for test requests 1-3 (Test Methods Q103A, Q113A, Q104D,

Q105, Q106, Q110A, Q111A)

Entering Results

When the test result page is opened, the test result editing is disabled. To enable editing, access
the grid context menu (right click on the grid) and unselect results: read only. If you need to also edit
sample numbers, also unselect sample no:read only. 

To add or edit a result, simply enter it into the grid in the appropriate column.

Reports

Reports are available from the reports drop down at the bottom left of the page. You can choose from
standard results reports which present the information currently shown in the grid and the concrete
results reports which show results specific to concrete testing.

When you select a concrete test report, you will see the form below in Fig 3. Civil Pro requires a
small amount of information to be able to create your concrete test result summary including;

The test result field containing the unconfined compressive strength for each of the cylinders
The f'c and f't for the mix you are reporting (If you have a test property group for your mix with the
properties f'c and f't set, you can select it in the mix properties)

Civil Pro will complete the concrete test analysis in accordance with the selected tests on the form.
For details of the tests, refer to MRTS 13.6 to 13.8.
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Fig 3 The concrete test result configuration

5.6 Quantities

The quantities register is used to view and record quantities for individual schedule items. Generally
adding, editing and deleting quantities is done through the lot register but this interface connects to
the same data source. Any changes here are reflected in the lot register and vice versa. 

The quantities register is accessed from the main menu and consists of only the main grid. To view
quantities for a schedule item, select it from the select schedule item drop down and click on the
OK button. The schedule item selector drop down is searchable in the same way described in the lot
quantities related items pop up.

New quantities are created by entering them directly into the grid (after enabling editing - available
through the grid context menu). To edit, enable editing and change the item as you want. Additional
columns are available by using the column chooser in the grid heading context menu. To delete
rows, select them and press the delete button.
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Fig 1. Quantities register showing quantities for 5101.01S

5.7 Specification/Inspection Test Plan

Each project will have a set of specifications that detail the requirements for acceptance of products
delivered under the contract. To communicate this to the project team, this is translated into a set of
documents called Inspection Test Plans. Each Inspection Test Plan is a list of items to check, and
test to verify conformance with the specifications. 

The Specification/Inspection Test Plan Register (ITP Register) is used to create both ITPs and
checklists. An ITP lists in detail the required inspection and testing performed on a specific element
of the work (say Subgrade Preparation) while a checklist or QVC is generally a subset of the ITP
that is used in the field as a record that the personnel responsible have verified conformance with the
specification. As both documents contain a significant overlap, it makes sense to prepare them from
the same data and avoid double entry.

The ITP register is accessed from the Main Menu and consists of the main grid, related items panel
and detail panel. New ITPs are created by typing directly into the main register, and then the
required inspection points are entered into the ITP Detail page, which is accessed by double clicking
the ITP or using the "Show ITP Detail" item from the context menu. 
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Fig 1. The ITP Register

ITP Records

An ITP record consists of the following
1. ITP Definition - The definition of the ITP (i.e. Embankment)
2. ITP Detail - Details of what is to be inspected (Ground Surface suitable, compaction testing

complete) for each ITP
3. ITP Testing - Information regarding any testing required for each ITP Detail

ITP Definition consists of;
Description The name of the ITP e.g. Embankment, Subgrade
QVC Doc No A document number to appear on the Checklist
ITP Doc No A document number to appear on the ITP
Revision ID An identifier for the revision shown
Spec
Reference

A reference to a clause in the specification
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5.7.1 ITP Details

The ITP Detail is the list of items to check for the ITP, who is responsible and how their inspection
will be documented. This data is also used to create checklists. The inclusion of items on either or
both of the QVC and the ITP is dependent on the QVC Incl. or ITP Incl. flags. Each ITP detail line
can have one or more tests recorded against it - refer to the Adding/modifying ITP tests topic.

IMPORTANT: Most of the time you want to see the data for a specification item in its ITP or QVC
format. You can switch between these different views by using the different Views available in the ITP
Detail context menu. Fig 1 shows the ITP format, while Fig 2 shows the QVC format.

The data which can be recorded for ITP details is;

Item Type Quality, Health and Safety, Environment, Community or Other - used as a sort filter
HP/WP/C Is this item a hold point, witness point, Milestone or just a check item
Description What is to be inspected (in detail)
Clause The specification clause related to this check item
Responsibility Who is responsible for ensuring the check is complete
Records How is completion of this check recorded and verified
Method of
Inspection

What method is used to check this item - visual inspection, concrete test, measure
with survey etc.

Incl QVC? Is this detail item included on the Checklist?
Alt QVC Text Use this text instead of the description on Checklists only.
QVC Text A readonly field. Cannot be edited. This displays the Alt QVC Text if it is not blank,

otherwise the description.
Inspection
Required

If unselected, the "Inspection Required" column of the checklist is greyed out

Verification
Required

If unselected, the "Verification Required" column of the checklist is greyed out

Authorization
Required

If unselected, the "Authorization Required" column of the checklist is greyed out
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Fig 1. ITP Details in ITP view
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Fig 2. ITP Details in QVC view

Alt. QVC Text - showing different descriptions on the ITP compared to the QVC
Although an ITP detail line may relate to the same underlying information for both the QVC and the
ITP, sometimes the specific text will differ between the two. You can change the text displayed on
the QVC simply by adding text to the "Alt QVC Text" field in the QVC view. When this field is
empty, the displayed text on the QVC will revert to the ITP description - assuming the QVC Incl.
checkbox is ticked.

Formatting Information
The long text fields in the ITP such as descriptions and the test compliance are all rich text capable.
This means that you can change the font, create bold and italic words etc. You can access this for
each individual field by right clicking on the field WHEN EDITING. You can also change the format
for the RTF fields for one or more records by using the "Format Selected" option in the context
menu- available on the main ITP menu and also on the ITP detail menu.

If you format selected at the ITP level, every ITP detail and ITP Test item is affected. At the Detail
level, only the selected detail items, and the tests for them are affected.

5.7.2 Importing and exporting ITPs

As well as importing and exporting single and multiple ITPs, you can import a file that gives an
association between ITPs and Schedule Items. These functions are available from the context menu
of the main ITP grid (right click on the ITP grid, and expand the File submenu).

Exporting
To export one or more ITPs select them in the grid and choose File=>Export ITP from the context
menu. You will notice that their are two export options - Single File or Separate Files. If you have
more than one selected, the former creates a single file containing all of the ITPs you have selected.
If you select separate files, a new file is created for each ITP.

Importing 
To import an ITP, use the File=>Import ITP option from the context menu. Select a .cpx file and it
will be imported.

Exporting Schedule vs. ITP
To export an ITP/Schedule, use the File=>ITP vs Schedule Export. This creates a file containing the
links you have created between your schedule items and ITPs. You will be prompted to remove the
trailing letters from schedule items. This allows you to make the relationship specific to the schedule
number, independent of any trailing characters such as P which may only indicate that the item is
provisional. Select yes or no as appropriate.
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5.7.3 Editing ITPs/QVCs

Editing Existing Entries
To edit an existing ITP, select the required ITP in the main register, the detail will be displayed in the
ITP Detail panel (if any exists). To edit the detail entries, Enable Editing using the detail grid's
context menu and make changes as you require.

It may be easiest to work on ITPs after dragging the entire ITP Detail panel into its own window to
achieve a maximum size. This is especially useful if you have multiple monitors.

New ITPs
If you need a new ITP, use the context menu to Enable Editing and add a new entry into the ITP
register. The new ITP will be placed in its correct (alphabetical) position in the list. Select it to enter
the detail.

TIP: If you are entering numerous ITPs and don't want the new item to be re-ordered, you can sort by
a different column by clicking the column header. Using the column chooser (right click grid column
menu) you can select the "Date Created" column and sort by that to keep the most recent entries at
the bottom.

Adding New ITP Details
Enable Editing using the ITP Detail grid's context menu. Either add new entries to the bottom of the
grid, or use the context menu item Insert New Row to insert a new row after the row you right-clicked
on. A description of the fields is found at Specification/Inspection Test Plan.

Re-ordering Rows
The order of the rows in the ITP Detail can be changed by drag and drop, simply left click on the row
you want to move, and while holding the mouse button, drag it to where you want. 

Editing QVC fields
Some fields relating specifically to QVCs are not shown in the default view. Do view these columns,
change the ITP Detail View to  Gird (all) or Grid (QVC). A description of the additional fields is found
at Specification/Inspection Test Plan.

Adding ITP Tests
To add tests to an ITP Detail, refer to Adding/Modifying ITP Tests.

5.7.4 Adding/modifying ITP tests

To add or modify tests, click on the "+" on the detail you want to add a test to. In Fig 1. the ITP
Tests are shown for the "General Fill material for the ..." ITP Detail in the Embankment ITP. In the
ITP Testing grid, enter the required information. The ITP Test Fields are;

Test Method What test type (from the Test Methods Register) is to be used for this test
Freq.(norm) Under normal testing frequency, how regularly is a test required - e.g. enter 500 for

1/500m3 (Normal or Reduced is set for each lot in the lot properties)
Freq.(red) Under reduced testing frequency, how regularly is a test required - e.g. enter 1000 for

1/1000m3 (Normal or Reduced is set for each lot in the lot properties)
Lot Freq.(norm)Under normal testing frequency, what is the minimum number of test per lot,

regardless of quantity
Lot Freq.(red) Under reduced testing frequency, what is the minimum number of test per lot,

regardless of quantity
Unit What is the unit of measurement for testing frequency
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Quantity Basis How is the quantity measured? Schedule Item, Lot Length, Lot Area, Lot Volume?
Compliance What are the requirements for the test result to be considered compliant

Fig 1: ITP Register showing ITP Tests

Optional Tests
When you have tests that are not always required, or are optional, you can mark these using the ITP
Test context menu item "Tag as Optional" . This is accessed by right clicking on the ITP Test grid. 

Optional tests are shown in light blue. Q103A in Fig 1 is an optional test.

To remove an optional test tag, select the ITP Test and use Remove Optional Tag in the context
menu.

An example of this would be with Pavement testing. It is common for early pavement tests to require
nuclear densometers to be verified with sand replacements with nuclear densometer allowed once
the reliability of the method is established. Then sand replacements are occasionally required in
future testing, but rarely. In this instance you could add the nuclear densometer as the required test
and the sand replacement as optional.

Or Sets
Sometimes there is more than one test type that can be used to complete a test. In this case you
can create an "Or Set". To create an Or Set, select the tests that belong to the set and select the
"Create Or Set" option from the ITP Testing context menu. The tests you have added to the set will
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be coloured green. Civil pro expects one of the tests to be selected as the default test. This is done
by double clicking the test you want as default. The other test will disappear but you will know it is
there due to the line's green colour (In Fig 1. the tests for the compacted layer method are part of an
Or Set - both are shown as the default has not yet been selected)

If you want to change which is default, double click the visible test and they will both be shown, then
double click the test you want to set to the default. When you create a Test Schedule for a lot, or a
checklist, you can search for any green coloured tests and change them to the other test if
appropriate. 

In the above example you could alternatively have an or set containing two test types;
1. Nuclear Densometer backed by Sand Replacement
2. Nuclear Densometer only
 

5.7.5 ITP selector

The schedule item selector appears whenever a user;
Adds/Edits a checklist
Adds links to work types and schedule items

Generally, you will select your ITPs and drag them to their destination (for example the Checklist
heading in the lot related items register).
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Fig 1. The ITP selector

When the ITP selector is invoked from a lot the items shown in the ITP selector are either;
The full list (All ITPs)
The ITPs linked to schedule items connected to the lot as quantities (Schedule Linked)
The ITPs linked to the lot's work type (Work Type Linked)

In Fig 1, only those ITPs linked by schedule are shown.

The search pane can be iterated through using the ctrl + s key shortcut. Entering a search term will
allow you to scan through the schedule for all entries with a particular search term.

5.8 Progress claims

Most contracts allow for progressive claims for payment to be made at regular intervals during the
project. Civil pro provides a way to enter record the quantities at time of claim and prepare a
progress claim automatically using these quantities. You can also create a snapshot of the
quantities against each lot, and use those as the basis of your progress claim.

To view the progress claims, click the Progress Claim button on the Main Menu opening the
Progress Claim form in Fig 1.



135Using civil pro

© 2014 Blue Sky Contracting P/L

Fig 1. The Progress Claim

5.8.1 Adding a progress claim

To add a new claim, click on the 'New Claim' button at the bottom left of the Progress Claim form
(ref. Progress claims Fig 1.).  Enter the required information into the form (fig 1 below);

New claim cutoff date - The date the progress claim is valid at
Description - Text describing the claim

Upon clicking the create button, there will be a delay as Civil Pro creates a copy of the schedule for
your new progress claim. You can now update the quantities manually for your progress claim, or
generate the quantities to date automatically based on your quality assurance records by taking a
snapshot (refer below)

Upon creating a new progress claim, all old progress claims will be locked, unlock using options
from the progress claim context menu (right click on the top grid in Fig 1). To update information for
a progress claim, Enable editing by selecting Enable Editing from the context menu and update the
required data.
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Fig 1. The New Progress Claim form

5.8.2 Snapshots and progress claim quantities

Now that you have a progress claim, you can complete the quantities in two ways;
1. Enter quantities manually
2. Pulling the quantities from the lot register

Preparing your claim manually
To prepare a new claim by manually entering quantities simply select the claim and enter the
quantities into the schedule.

Preparing your claim using Lot Quantities
To use you lot quantities to build a claim
1. Select the claim to work with
2. Use the context menu to select the Take Snapshot option. The dialog in Fig 1a will appear. To

include all quantities currently in Civil Pro, click on Create. To limit the quantities to a cutoff date,
unselect the Include all quantities in Civil Pro option and the form will appear as shown in Fig 1b.

3. Expanding the schedule items will reveal an additional two levels of data (refer fig 2. below) - the
first for status (conformed guaranteed or open) the second is a list of the lot quantities for each
schedule item

4. At this point, the quantities for your progress claim will remain unchanged. To actually update
your progress claim to reflect the detail in your snapshot, use the Claim=Snapshot option from
the context menu for the progress claim. This will set the schedule item quantities to equal the
sum of the lot quantities. To include/exclude particular statuses, and to summarize quantities
prior to a specific date, refer to customizing and printing progress claims.

Fig 1a - Taking a snapshot including all quantities



137Using civil pro

© 2014 Blue Sky Contracting P/L

Fig 1a - Taking a snapshot including quantities up to a specific date

Fig 2 Progress claim showing snapshot of lot quantities



138 Civil Pro Help v8.8.51

© 2014 Blue Sky Contracting P/L

5.8.3 Customizing and printing progress claims

Changing the detail of Lot Quantity Reporting - Split Date

Generally you won't want to see every lot quantity for the entirety of your project. Civil pro allows you
to summarize lot quantities prior to a certain date into a single line. To set the split date, update the
"Split Date" text box at the bottom of the Progress Claim Detail panel. These changes will be
reflected in progress claim reports.

Changing what status of Lot Quantities are included in the Claim

By default all Lot Quantities are shown and included when the "Claim=Snapshot" function. To
change the visible Lot Quantities, use the Progress Claim Detail context menu items under "Status
to Show". Those items selected will be displayed and also included when the "Claim=Snapshot"
function is used.

Reflecting changes to schedule items

If your schedule changes (maybe you added some schedule items for variations), you can update
the progress claim detail by selecting the progress claim and using the "Rebuild Claim" function
from the context menu.

Printing your progress claims

To print your progress claim, or compare it to a previous progress claim, select the appropriate
report from the Reports option at the bottom of the Progress Claim form.

If you need to create a report showing the quantities supporting your progress claim, select the
"Print Snapshot Quantities" report.

5.9 Variations

The Variation Register is used to create a register of changes to the contract, usually impacting on
payment. Each variation can be connected lots, schedule items and photos.

The Variation register is accessed from the Main Menu and consists of the main grid, related items
panel and detail panel. New Variations are created using the New Variation wizard - accessed from
the New Variation button in the bottom left of the page. Changing the selected item in the Variation
Register will change the list of related items. To see the image preview page (hidden by default)
double click on a Variation or select the Show Preview Panel option from the context menu (right
click the grid).
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Fig 1. The Photo Register showing the preview panel

Variation Records

A Variation record consists of;

Variation No A unique identifier for each variation

Description * A description of the variation

Client Ref An optional field to store an alternative reference such as one used by the
client

Date Identified The date the variation was identified

Date Notified The date the variation was notified to the client

Date Approved The date the variation was approved by the client

Variation Status The current status of the variation - available values are in the Variation
Status Register

EOT Days The number of days EOT related to this VRN

Raised By Who raised or is responsible for this VRN

Notes Comments regarding the variation

Adding New Variations
New variations are added using the New Variation Wizard
Relationships with other civil pro data are viewed and managed using the Related Items panel

Creating payment items for variations 
Once a variation is approved (or perhaps before) you will want to create a payment item for the
variation. To do this, select the variation and from the context menu (right click on the grid) select
the New Schedule from VRN option. Complete the information (Fig 2) regarding rates, units and
quantities and click create. A new schedule item is added to your schedule items register and a link
to the schedule item is created in the variation.
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You will probably want to review your schedule items if you have structures you wish to maintain as
the new schedule item will just be placed at the root level after the last schedule item.

Fig 2. Creating a schedule item from a variation

5.9.1 Variation detail

The Variation detail panel (shown in Fig 1.) is displayed at the bottom of the Variation register. It is
hidden by default but can be shown by double clicking any Variation record or selecting the "Show 
Variation Details" option from the grid context menu.  To create more real estate to view the grid,
simply close or hide the detail panel using the blue buttons in the top right. When the mouse is over
the buttons, the right one will show a cross - click to close, the left one will show a pin - clicking it
toggles between auto-hide and fixed positioning.

Fig 1 VRN Detail panel

The Variation detail page shows all of the available information for a single record and changes as
you navigate to a different VRN in the register. The form is editable by default, except for the VRN
Number. The VRN number can only be edited after selecting 'Edit VRN Number' from the detail panel
context menu.

For more information on the information stored for each VRN, refer to the VRN Register.
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5.9.2 Related items

The related items panel allows users to quickly see information associated with a Variation (Lots,
photos and schedule items). This and similar mechanisms in the Lot register are the only way to
create associations between Variations and Lots, Variations and Schedule Items and Variations and
photos. When you move between Variation in the Variation register, the related items list will show
the lots and photos linked to the Variation.

Fig 1. The Variation Related Items

To add a new link between a lot and a Variation, double click the Lots heading in the related items
list - A list of lots will pop up. Select the lot(s) you want to add and drag them onto the Related
Items list. To see the detail of a lot, double click it and the lot register will open displaying the
clicked lot. To delete a relationship, select it and click delete.

The related photos list shows any photographs stored in civil pro that are related to the Variation. To
associate them, follow the same procedure as for adding a lot to the Variation, but double click on
the Photo heading instead.

The related schedule items list records the schedule items used to collect payment for a variation.
To associate a schedule item, double click the Schedule Items heading, select the schedule item(s)
from the list and drag and drop it over the heading. This link can also be made form the schedule
items list.

5.9.3 New variation

The new Variation wizard simplifies the creation of a new lot by undertaking the task step by step.
To access the new Variation wizard, click on the New Variation button on the bottom of the Variation
Register. For information on what each of the fields is for (Description, Raised By, Date Variation
Identified etc.) refer to the Variation Register section.
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Fig 1. New Variation Wizard Page 1 - Basic NCR information

Enter basic Variation information including the description and date identified. Civil pro will try and
calculate an automatic Variation No.

Fig 2. New Variation Wizard Page 2 - Lots associated w ith this Variation

Select lots related to your Variation. Press the tab key to assign the lot and add more if you require.
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Fig 3. New Variation Wizard Page 3 - Summary

Review the summary of the information civil pro has collected for your Variation and click Finish if it
is OK. To correct information go back through the wizard by clicking the back arrow in the top left of
the wizard.

5.10 Photographs

The Photo Register is used to create a library of images and connect them to the records in civil pro
to which they relate.

The Photo register is accessed from the Main Menu and consists of the main grid, related items
panel and detail panel. New photos are created using the New Photo wizard - accessed from the
New Photo button in the bottom left of the page. Changing the selected item in the Photo Register
will change the list of related items. To see the image preview page (hidden by default) double click
on a Photo or select the Show Preview Panel option from the context menu (right click the grid).
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Fig 1. The Photo Register showing the preview panel

Photo Records

A Photo record consists of;

Photo ID A sequential number for each photo - generated automatically by civil pro

Description * A description of the non-conformance

Photo Date * Where the non-conformance is located

Adding New Photos
New photos can be added in three ways;

Enter a new photo record in the grid. Add a new image using the Get Image function on the
Preview Panel context menu
Use the New Photo wizard and update the grid entry after importing. The New Photo wizard and
Batch Import functions use the same interface.
Use the Batch Import function from the context menu and import numerous photos at once. Then
update the imported entries in the grid.

Image Swapping and Downloading
To change a photo record's image, select the Get Image option from the Preview Panel Context
Menu (accessed by right clicking on the preview panel). Select the replacement photo, and click
OK in the import wizard.
Saving a picture (for example to an external device or to send in an email) use the Save Image As
function from the Preview Panel context menu.

Photo Manipulation
Each image in civil pro can be manipulated using civil pro's image manipulation tools. The image
manipulation tools are accessed from the Preview Panel's context menu (accessed by right clicking
on the preview panel). Zooming functions are also performed with the mouse scroll wheel.
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The available functions are;

Rotate

- Left Rotates the image left 90 degrees

- Right Rotates the image right 90 degrees

- 180 degrees Turns the image upside down

Flip

- Horizontal Flips the image horizontally

- Vertical Flips the image vertically

Zoom

- Zoom In Increases the zoom 

- Zoom Out Decreases the zoom

- Fit Resizes the image to fit the panel while maintaining the aspect ratio

- Actual Size Changes the zoom to 100%

- Stretch to Fit Stretches the photo to fill the available panel area regardless of aspect ratio

Left Click
Zoom

When enabled, left clicking and dragging a window on the image zooms to
that window

5.10.1 Related items

The related items panel allows users to quickly see information associated with a Photo (Lots,
Variations and NCRs).  This and similar mechanisms in the NCR,VRN and Lot register are the only
way to create associations between these objects and photos. When you move between photos in
the Photo register, the related items list will show the lots, NCRs and VRNs linked to the photo.

Fig 1. The Photo Related Items

To add a new link between a photo and a lot, double click the Lot heading in the related items list -
A list of lots will pop up. Select the lot(s) you want to add and drag them onto the Related Items list.
To see the detail of a lot, double click it and the lot register will open displaying the clicked lot. To
delete a relationship, select it and click delete.

The related VRNs and NCRs list shows any photographs stored in civil pro that are related to the
photo. To associate them, follow the same procedure as for adding a lot to the photo, but double
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click on the VRN or NCR heading instead.

5.10.2 Photo import / new photo wizard

The Photo Import form is used in all methods of importing one or more images into civil pro. This
includes;

the New Photo function at the bottom of the Photo Register
the Batch Import function
the Get Image function accessed from the Preview Panel context menu

When these functions are invoked, a dialog appears. Select a file (or multiple files for the Batch
import) and the Import form appears.

Fig 1. The Photo Import page - showing images imported using the Batch Import

This page allows you to adjust the storage size of the files you are importing. To adjust the image
quality and dimensions, move the Quality and Dimensions sliders. The image preview will be
updated and the size on disk recalculated. The quality and size settings you have selected will be
applied to all images in the batch.

When you have completed the import, a record will exist in the Photo Register for each image, and
your images will be attached to them. The descriptions in the register will need to be updated. Civil
pro will try to determine the photo date from the photo's properties. If it cannot, you will also need to
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update the Date field.

Create links to other records in civil pro using the Related Items panel.

5.11 Document control

The civil pro document management module records the drawings, specifications, contracts or
management documents for a project. The list of documents is called the document register. The
document register also records when a document is reissued with revisions.

When documents are revised, other members of the project generally need to be advised. For this
reason each document is associated with a list of people that need to be advised of changes. The
link between people and documents is referred to as the document distribution list.

When one or more documents change, the people on the distribution list need to be advised. This is
formally managed through the creation of a Document Transmittal in the transmittal register.

5.11.1 Document register

The document register is a list of drawings, specifications, contracts or management documents for
a project.There is no restriction on what documents can be listed in the register.

To create a new document, simply enter the data in a new row (you will need to ensure that the
Enable Editing option has been selected from the context menu). The information collected for each
document is;

Document number * Any unique identifier. By default is created from the work type, area
code and an auto generated index.

Description * A description of the document

Doc group Any text - used to differentiate between document groups

Doc type Any text - used to differentiate between document types

Controlled by Any text - the person or entity responsible for advising of revisions to
the document

Document date * The date recorded on the document as its date of issue

Date received * The date the document was received

There are two additional, readonly fields; Last Rev and Last Rev Date. These fields are populated
when a document has one or more revisions to provide a summary of the last revision to the
document.

Drop Down Lists
Three of the columns (Doc Group, Doc Type and Controlled By) have drop down lists. These lists are
simply a summary of previous entries for the respective field, so the first time you add a record the
list will be empty. After you have added a record in which you provide, for example, a doc type (by
typing straight into the grid), that doc type will appear in the list the next time you drop it down.
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Fig 1 The document register showing the distribution list for RW100 and two revisions a, and b.

Distribution List
The distribution list for each document can be viewed in the related items panel accessed using the
right click context menu. Add a person to the list by double clicking on "Distribution" in the Related
Items panel, a popup will appear with a list of users. Drag the user(s) to add on to the distribution
list.

Import and Export
The document register can be created or appended to by importing from the clipboard or a CSV file.
Simply select the "Import Doc Register" option from the right click context menu. For more on
importing, refer to importing data. Data is exported in a similar way, simply select the rows you want
to export (or control+A for all records) and select "Export Doc Register" from the right click context
menu.

Revising documents
To create a record for a document revision, select the document and enter the details for the revision
in the "Revisions" pane at the bottom of the register. If the revision pane is not visible, double click
the record, or select Show Revisions from the context menu.

The information recorded for a document revision is;

Rev. ref * A text identifier for the revision - usually taken from the document
itself i.e. Rev A. 

Description * A description of the changes to the document

Revision date The date the document was revised
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Date received The date the revision was actually received. This is usually different
from the revision date and is a key piece of information in the case
of a dispute

Revised by Any text - the person or entity responsible for managing revisions to
the document. The drop down list for this field behaves similarly to
that for the the doc groups and doc types in the main document
register.

Reports
The document register can be printed by selecting the option from the reports menu.

5.11.2 Document distribution

Each document recorded in civil pro can be associated with one or more users via its distribution
list. The distribution list is how civil pro can automatically determine who needs to be advised (via a
Transmittal) when a document is revised.

The distribution list for each document can be viewed in the related items panel of the Document
Register. Add a person to the list by double clicking on "Distribution" in the Related Items panel, a
popup will appear with a list of users. Drag the user(s) to add on to the distribution list.

To see the list of documents circulated to a user, open the people register and select "Show Doc.
Distribution" from the right-click context menu. A panel will appear showing the documents on the
distribution list for the currently selected user. Add a document to the list by double clicking on
"Document" in the Related Items panel, a popup will appear with a list of documents. Drag the
document(s) to add on to the distribution list.

If you need a report of the documents distributed to each user, this report is available from the
Reports menu of the People register.

5.11.3 Transmittal register

A transmittal is used to officially notify people that a document has been revised. To create a
transmittal, simply enter the data in a new row (you will need to ensure that the Enable Editing
option has been selected from the context menu). The information collected for each transmittal is;

Transmittal ID A unique identifier automatically generated by civil pro

Description * A description of the transmittal - Revision Advice by default when
automatically creating transmittals

Transmittal To The person the user is addressed to

Transmittal Date The date the transmittal is generated

Date Confirmed If you are tracking when transmittals are acknowledged as having
been received, the date can be recorded here.

Each transmittal has a list of documents, a specific revision for, and a quantity of each
accompanying the transmittal. These can be added manually in the Transmittal Items panel - this is
accessed by double clicking the transmittal or selecting the Show Transmittal Items option from the
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context menu. They can also be added by double clicking the "Docs Transmitted" heading in the
Related Items panel, and dragging the appropriate document onto the heading.

Automatically adding revisions
If you know a person needs to be advised of changes to documents on their distribution list, create a
transmittal and select "Add Outstanding Docs" from the context menu. Any document whose latest
revision hasn't been transmitted will be added to the transmittal.

Automatically creating outstanding transmittals
For a list of all users with outstanding transmittals, use the "List Un-transmitted Users" option from
the context menu. In the popup of users with outstanding transmittals, selecting one or more and
clicking the OK button will automatically create new transmittals for the selected users and add the
outstanding documents.

Seeing more documents and revisions
When you are presented with lists of documents to add to the transmittal, it will show either;
i) Documents with un-transmitted revisions
ii) The documents distributed to the person to whom the transmittal is addressed
iii) All document

By default, only documents with un-transmitted revisions are shown in the drop down lists. This can
be changed by altering the selection in the context menu.

Reports
One or more transmittals can be printed by selecting them and clicking on the "Print Transmittal"
option in the Reports menu at the bottom of the form.

The transmittal register can be printed by selecting the option from the reports menu.
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Fig 1: Transmittal Register

5.12 Production Management

This module is a simple tool for tracking daily costs and production and doing simple analyses to
identify performance across one or more cost codes. It is an alpha feature of Civil Pro and is not
supported yet, but you are welcome to try it out and tell us what you think.

5.12.1 Cost Codes

Before starting to use the production module, you must define your cost codes. Other data such as
your suppliers can be added on the fly as you use them, but the cost codes must be defined prior to
actually entering data that references the costs code. You can add more later, you simply must do
so through the cost code register rather than being able to actually enter it straight in to the cost/
production register.
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Fig 1: The cost code data entry screen

The required data is relatively straightforward.
Cost Code Name - the code you use to track a set of costs - this will be seen in the cost/
production tracking screen
Description - information detailing what is covered in this code
Budget - the unit rate budgeted for this activity
'Unit - the unit of measurement
Schedule Item - if this maps to a schedule item, here is where you can link it.

5.12.2 Cost vs. Production

Once you have entered cost codes, you don't actually have to enter any more information into the
registers, these can be populated as you enter data into the Cost vs. Production register. The
Resources and Suppliers registers are simply a record of the different suppliers and the resources
they provide, along with the rate at which they supply these resources. Information about these two
registers are in separate help topics.
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Fig 1: Cost vs. Production Data Entry

Simply add data for each resource on each day into the bottom half of the screen. In the top half,
add what quantity of production was achieved for each cost code by the resources you have entered.
Civil Pro will calculate the unit rate of production on a day by day basis.

5.12.3 Suppliers

The suppliers register is simply a list of the companies from which you purchase supplies, services
or hire equipment. Adding or deleting from this register will not affect your data that is already
entered into the resources or cost vs. production registers. Adding additional suppliers will make
them available from the drop down selectors in the resources and cost vs. production registers.

When you add a new record in cost vs. production that has a new supplier, they are automagically
added to the supplier register.
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Fig 1: Suppliers Register

 

5.12.4 Resources

The resources register is a list of the resources supplied by the suppliers with which you do
business and includes materials purchased, equipment or plant hired and labour - either external or
internal. Adding or deleting from this register will not affect your data that is already entered into the
cost vs. production register. Adding additional resources will make them available from the drop
down selectors in the cost vs. production register.

When you add a new record in cost vs. production that has a new resource, they are automagically
added to the resources register.
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Fig 1: Resources Register
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6 System administration

Managing your civil pro install is relatively easy. The most important task - backup and restore is as
simple as making sure you have a copy of your standalone civil pro file, or backing up your SQL
server. Both of which are simple tasks to automate.

If you want to create a template for your new projects, you can copy the template straight into a
read-to-go project file using the transfer project data function.

Have you got civil pro v7 data? No problem, just import and the check for accuracy using the civil pro
v7 importer.

6.1 Backup and restore

Methods for backup and restore of civil pro systems depend on whether you are using a standalone
or server install. If you are using a standalone (i.e single project) install, simply copy the file
containing your project to the backup location as if it was any other file you are backing up. If you
have an automated backup, you need only ensure that the backup is copying files from the civil pro
directory.

If you are using a server install, you need to backup the database on the SQL server. This is a
sysadmin responsibility and it is assumed if you have this kind of civil pro system that you have
suitably qualified personnel to undertake this task. Performing an SQL server backup is not a
particularly complicated task but is beyond the scope of this manual. Backing up an SQL server is
described  in detail at;
http://msdn.microsoft.com/en-us/library/ms187510.aspx 

6.2 Transfer project data

Copying a civil pro project is relatively easy and is achieved using the Project => Import/Export =>
Transfer Project Data function from the system menu. One of the most common uses for a copy is
where you have a template project that you want to use for all new projects. Simply select the
project and copy it to either your server, or a standalone database. You can also use these
templates during the project initialization.

The copy is not recommended as an alternative to the backup and restore mechanisms you should
be employing to protect your data.

Using this function you can;
Server Install
1. Copy a project from a server install to a standalone file
2. Copy a project from a server install to a new project on the same, or another server

Standalone
1. Copy a standalone project to a server install
2. Copy a standalone project to a new standalone project

In civil pro there is a difference between a copy and a clone. A clone is an identical, standalone
replicate of a server-based project that can be used offline, and then re-integrated with the database.
You cannot clone a standalone database.

http://msdn.microsoft.com/en-us/library/ms187510.aspx
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Step 1 Select the source project. You can opt to use the current project (Fig 1A) or choose a
different project (Fig 1B). If you choose a different project, this can be selected as either a
standalone or server install using the "Select Source" options.
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Fig 1A (left) and 1B (right): Selecting a project to copy as either the current project you are logged in to

(Fig 1A) or a different project (an existing SQL server install is shown in Fig 1B)

Step 2: Chose the target database - either a server or standalone project. If a standalone project is
selected, the destination project must be a new file. You cannot copy over an existing civil pro
standalone project or have multiple projects in the one file.
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Fig 2: Selecting a destination project. A standalone file type is shown

Step 3: Select the data you wish to copy - this can either be the whole project, or a selection from
within the setup data.
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Step 4; If you want, you can give your project new details (unless you are copying setup information
to an existing project).



162 Civil Pro Help v8.8.51

© 2014 Blue Sky Contracting P/L

Fig 4: Rename the project

Step 5: Confirm the project details and click the "Start Transfer" button to begin the copy.
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Fig 5: Confirm the copy details
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